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Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly 
on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, 
such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow 
the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the 
AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1
Product description

Category Description

HP EliteBook 
8440p 
Notebook PC
UMA 

HP EliteBook 
8440p 
Notebook PC
Discrete 

HP EliteBook 
8440w 
Mobile 
Workstation 

Product Name HP EliteBook 8440p Notebook PC  

HP EliteBook 8440w Mobile Workstation 

Processors Intel® Core™ i5 dual-core processors:

i5-520M, 2.4-GHz processor (Turbo up to 
2.93 GHz), 3-MB L3 cache, 4 threads (35W)

i5-540M, 2.53-GHz processor (Turbo up to 
3.06 GHz), 3-MB L3 cache, 4 threads (35W)

Intel® Core™ i7 dual-core processors:

i7-620M, 2.66-GHz processor (Turbo up to 
3.33GHz), 4-MB L3 cache, 4 threads (35W)

Intel® Core™ i7 quad-core, processors:

i7-720QM, 1.6-GHz processor (Turbo up to 
2.8 GHz), 

i7-820QM, 1.73-GHz processor (Turbo up to 
3.06 GHz), 8-MB L3 cache, 8 threads (45W)

 

Chipset Intel® PCH QM57 - Enhanced

Graphics Intel® Unified Memory Architecture (UMA) 
graphics subsystem integrated with shared system 
memory (dynamically allocated; Intel® Graphics 
Media Accelerator HD) 

Nvidia N10M-NS discrete graphics card with 
512 MB of GDDR3 800 MHz graphics subsystem 
memory

Nvidia N10M-GLM NS discrete graphics card with 
512 MB GDDR3 800 MHz (64 MB x 16 x 4) 
graphics subsystem memory

Panel All display assemblies include three wireless local 
area network (WLAN) antennas and two wide-area 
network antennas (WWAN)

14.0-in 16:9 HD (1366 x 768) AntiGlare LED 
display

14.0-in 16:9 HD (1366 x 768) AntiGlare LED 
display with webcam

14.0-in 16:9 HD+ (1600 x 900) AntiGlare LED 
display

(Continued)
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Product description
14.0-in 16:9 HD+ (1600 x 900) AntiGlare LED 
display with webcam

Support privacy filter 

Memory Two customer-accessible/upgradable memory 
module slots 

Supports dual-channel memory 

DDR3 PC3-10600 1333-MHz memory

Supports the following configurations: 

■ 8192-MB total system memory (4096 x 2)

■ 4096-MB total system memory (4096 x 1)

■ 4096-MB total system memory (2048 x 2)*

■ 3072-MB total system memory (2048 + 1024)*

■ 2048-MB total system memory (2048 x 1)*

■ 2048-MB total system memory (1024 x 2)*

■ 1024-MB total system memory (1024 x 1)*
*Brazil 1333-MHz memory configuration

Hard drives Supports 9.5-mm, 6.35-cm (2.5-in) hard drives 

Customer-accessible 

Serial ATA 

Supports the following drives:

■ 500 GB, 7200 rpm 

■ 320 GB, 7200 rpm

■ 250 GB, 7200 rpm

Supports the following solid-state drives:

■ 256 GB

■ 160 GB

HP 3D DriveGuard

RAID 0/1 Support

Optical drives Fixed (removal of 1 screw required) 

Customer-accessible 

Serial ATA 

12.7-mm (0.50-in) drive tray

Supports the following drives:

■ Blu-ray R/RE DVD±RW SuperMulti Drive

■ Blu-ray ROM with LightScribe DVD±RW 
SuperMulti DL Drive

■ DVD±RW and CD-RW SuperMulti Double-Layer 
Combo Drive with LightScribe

■ DVD-ROM Drive

(Continued)
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Product description
Upgrade drive bay 9.5-mm, 6.35-cm (2.50-in) HDDs

500 GB 7200 rpm

Supports "No Drive" option

Diskette drive Supports external USB diskette drive only 

Microphone Integrated dual-array microphone 

Audio HD audio 

Two stereo speakers

Webcam Integrated 2.0-megapixel webcam

Modem High-speed 56k modem 

Modem cable not included

Support for No-Modem option in the Asia Pacific, 
Japan, and Latin America regions

Ethernet Intel 10/100/1000 network interface card (NIC) with 
iAMT

S3/S4/S5 wake on LAN 

NIC power down technology 

Ethernet cable not included

Wireless Integrated wireless local-area network (WLAN) 
options by way of WLAN module:

Three WLAN antennas built into display assembly

Support for no WLAN option 

Support for the following WLAN formats:
• Broadcom b/g
• Intel 802.11a/b/g
• Intel 802.11a/g/n 2×2
• Intel 802.11a/g/n 3×3

Integrated wireless wide-area network (WWAN) 
options by way of WWAN module:

Two five-band WWAN antennas built into display 
assembly

Subscriber identity module (SIM) security 
(customer-accessible in battery bay)

Support for the following WWAN formats:

■ Qualcomm WW evolution-data optimized 
(EVDO), high-speed downlink packet access 
(HSDPA)

■ Ericsson HSDPA 

Supports WWAN after-market options

Integrated personal area network (PAN) options by 
way of Bluetooth® module

Support for no PAN option

(Continued)
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Product description
Digital card One ExpressCard/54 slot 

Integrated secure digital (SD)/ MultiMedia card 
(MMC) card reader

Ports Audio-in (stereo microphone) 

Audio-out (stereo headphone) 

DisplayPort digital display interface 

RJ-11; modem

RJ-45; Ethernet, with link and activity lights 

USB 2.0 (3)

USB 2.0/eSATA combo (1)

VGA (D-sub 15) supporting 1600 × 1200 external 
monitor at 75-Hz (hot plug/unplug with auto-detect)

1394a

Multi-pin AC port 

Docking HP docking station 

HP advanced docking station 

Keyboard/pointing 
devices 

11.97-in keyboard with embedded numeric keypad

Spill-resistant keyboard

Dura-Keys

Vertical and horizontal scrolling, taps enabled as 
default

Dual point (pointing stick and TouchPad) with 2 
pointing stick buttons and 2 TouchPad buttons and 
vertical scrolling (taps enabled as default)

Power requirements Supports the following AC adapter with localized 
cable plug (3-wire plug with ground pin and 3-pin 
DC connector):

• 65-W “Smart” adapter

• 90-W “Smart” adapter

9 cell Li-ion battery (100 Wh) 3.0 Ah (does not 
support HP Fast Charge)

6 cell Li-ion battery (55 Wh) 2.55 Ah

6 cell 1000-cycle battery (51 Wh) 2.55 Ah

4 cell Li-ion battery (37 Wh) 2.55 Ah

Support for 8-cell Li-ion Extended Life battery

Support for 12-cell Ultra Capacity battery 

(Continued)
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Product description
Security Integrated HP Fingerprint sensor (select models 
only)

Integrated smart card reader 

Security cable slot 

Trusted platform module (TPM) V.1.2 

Full volume encryption 

Preboot authentication (password, smart card, 
biometric)

Operating system Preinstalled:

Vista Basic 32 with Microsoft Basics

Windows XP Professional SP3 (EN, FR, JP) with 
Microsoft Basics 

Windows Vista Business SP1 32 with Microsoft 
Basics

Windows 7 Home Premium 32 with Microsoft 
Basics (Japan only)

Windows 7 Home Premium 64 with Microsoft 
Basics (Japan only)

Windows 7 Professional 32 with Microsoft Basics  
(Japan only)

Windows 7 Professional 64 with Microsoft Basics 
(Japan only)

XP Professional SP3 with Microsoft Basics (with 
Windows 7 Professional COA; Japan only)

FreeDOS

Preinstalled with Office:

Vista Basic 32 with Office 2007 Ready (not 
available for Japan)

Vista Basic 32 with Office 2007 Personal (Japan 
only)

Vista Basic 32 with Office 2007 Personal with 
PowerPoint (Japan only)

Vista Basic 32 with Office Professional (Japan 
only)

Windows Vista Business 32 with Office Ready (not 
available for Japan)

Windows Vista Business 32 with Personal (Japan 
only)

Windows Vista Business 32 with Personal and 
PowerPoint (Japan only)

Windows Vista Business 32 with Professional 
(Japan only)

(Continued)
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Product description
Windows 7 Home Basic 32 with Office 2007 Ready 
(not available for Japan)

Windows 7 Home Premium 32 with Office 2007 
Ready (not available for Japan)

Windows 7 Home Premium 32 with Office 2007 
Personal (Japan only)

Windows 7 Home Premium 32 with Office 2007 
Personal with PowerPoint (Japan only)

Windows 7 Home Premium 32 with Office 2007 
Professional (Japan only)

Windows 7 Home Premium 64 with Office 2007 
Ready (not available for Japan)

Windows 7 Home Premium 64 with Office 2007 
Personal (Japan only)

Windows 7 Home Premium 64 with Office 2007 
Personal with PowerPoint (Japan only)

Windows 7 Home Premium 64 with Office 2007 
Professional (Japan only)

Windows 7 Pro 32 with Office 2007 Ready (not 
available for Japan)

Windows 7 Pro 32 with Office 2007 Personal 
(Japan only)

Windows 7 Pro 32 with Office 2007 Personal with 
PowerPoint (Japan only)

Windows 7 Pro 32 with Office Professional (Japan 
only)

Windows 7 Pro 64 with Office 2007 Ready (not 
available for Japan)

Windows 7 Pro 64 with Office 2007 Personal 
(Japan only)

Windows 7 Pro 64 with Office 2007 Personal with 
PowerPoint (Japan only)

Windows 7 Pro 64 with Office Professional (Japan 
only)

Windows XP Pro (with Windows 7 Pro COA) with 
Office Ready (not available for Japan)

Windows XP Pro (with Windows 7 Pro COA) with 
Personal (Japan only)

Windows XP Pro (with Windows 7 Pro COA) with 
Personal and PowerPoint (Japan only)

Windows XP Pro (with Windows 7 Pro COA) with 
Professional (Japan only)

(Continued)
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Product description
Restore Media: 

Windows Vista Ultimate 32 

Windows Vista Business 32/64 

Windows Vista Home Basic 32 

Windows XP Professional 

DRDVD Windows XP

DRDVD Windows Vista 

DRDVD Windows 7

DRDVD Windows 7 with WinDVD

Windows XP Professional 

Windows Vista Business 32

Windows Vista Business 64

Windows 7 Home Basic 32

Windows 7 Home Premium 32

Windows 7 Home Premium 64

Windows 7 Pro 32

Windows 7 Pro 64

Certified: 

SUSE Linux Enterprise Desktop

Web-only Support:

Windows XP Pro 64

Windows Vista Business 64

Windows Vista Enterprise 32

Windows Vista Enterprise 64

Serviceability Customer replaceable parts: 

AC adapter 

Battery (system) 

Hard drive 

Solid-state drive 

Memory module 

Optical drive 

Mini-PCI components

Category Description

HP EliteBook 
8440p 
Notebook PC
UMA 

HP EliteBook 
8440p 
Notebook PC
Discrete 

HP EliteBook 
8440w 
Mobile 
Workstation 
Maintenance and Service Guide 1–7



Product description
1–8 Maintenance and Service Guide



2
External component identification

Identifying hardware

Components included with the computer may vary by region and model. The illustrations in this chapter identify 
the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

In Windows® 7:

» Select Start > Control Panel > System and Security > Device Manager.

You can also add hardware or modify device configurations using Device Manager.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

In Windows Vista®:

1. Select Start > Computer > System Properties.

2. In the left pane, click Device Manager.

You can also add hardware or modify device configurations using Device Manager.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

In Windows XP:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, select View system information.

3. Select Hardware tab > Device Manager.

You can also add hardware or modify device configurations using Device Manager.
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External component identification
Top components

Display components

✎ The computer may look slightly different from the illustration in this section.

Item Component Description

(1) Internal display switch Turns off the display and initiates Sleep (Windows 7 and Windows Vista) or 
Standby (Windows XP) if the display is closed while the power is on.

(2)  Internal microphones (2) Record sound.

✎ If there is a microphone icon next to each microphone opening, the 
computer has internal microphones.

(3) Webcam light On: The webcam is in use. 

(4) Webcam Records video and captures still photographs.

(5) Keyboard light Illuminates the keyboard in low-light conditions. The keyboard light is 
embedded in a push/push switch. You push the keyboard light cover to open 
and turn the light on. Push again to close and turn the light off. 
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External component identification
Wireless antennas (select models only)

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that 
applies to your country or region. These notices are located in Help and Support.

Item Component Description

(1) WWAN antennas (2)* (select 
models only)

Send and receive wireless signals to communicate with wireless wide-area 
networks (WWANs).

(2) WLAN antennas (3)* (select 
models only)

Send and receive wireless signals to communicate with wireless local area 
networks (WLANs).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around 
the antennas free from obstructions.
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External component identification
Buttons, switches, and fingerprint reader

Item Component Description

(1) Power button ■ When the computer is off, press the button to turn on the computer.

■ When the computer is on, press the button to shut down the computer.

✎ Although you can shut down the computer with the power button, the 
recommended procedure is to use the Windows Shut Down command.

■ When the computer is in the Sleep state (Windows 7 and Windows Vista) 
or Standby (Windows XP), press the button briefly to exit the Sleep state 
(Windows 7 and Windows Vista) or Standby (Windows XP).

■ When the computer is in Hibernation, press the button briefly to exit 
Hibernation.

If the computer has stopped responding and Windows shutdown procedures 
are ineffective, press and hold the power button for at least 5 seconds to turn 
off the computer.
To learn more about power settings:

■ In Windows 7: Select Start > Control Panel > System and Security > 
Power Options.

■ In Windows Vista: Select Start > Control Panel > System and 
Maintenance > Power Options.

■ In Windows XP: Select Start > Control Panel > Performance and 
Maintenance > Power Options.

(2) Internal display switch Turns off the display if the display is closed while the power is on.

(3) QuickLook button Allows you to save calendar, contact, inbox, and task information from 
Microsoft Outlook to the hard drive of the computer. When the computer is off 
or in Hibernation, press the QuickLook button to view this information without 
waiting for the operating system to restart. 

(4) QuickWeb button Opens the Web browser.

(5) Wireless button Turns the wireless feature on or off but does not establish a wireless 
connection

(Continued)
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External component identification
(6) TouchPad button Turns the TouchPad on or off.

(7) Caps lock button Turns caps lock on or off.

(8) Num lock button Turns num lock on or off.

(9) Volume mute button Mutes and restores speaker sound.

(10) Volume down button Decreases speaker volume.

(11) Volume up button Increases speaker volume.

(12) Fingerprint reader (select models 
only)

Allows a fingerprint logon to Windows, instead of a password logon.

Item Component Description
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External component identification
Keys

✎ The computer may look slightly different from the illustration in this section.

Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Use like an external numeric keypad when you enable the num lock function 
by pressing the fn key in combination with the num lk key.

(6) Function keys Execute frequently used system functions when pressed in combination with 
the fn key.

■ Display system information. fn+esc

■ Initiate Standby or Sleep. fn+f3

■ Switch the screen image. fn+f4

■ Display battery information. fn+f8

■ Decrease screen brightness. fn+f9

■ Increase screen brightness. fn+f10

■ Activate the ambient light sensor. fn+f11
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External component identification
Pointing devices

Item Component Description

(1) Pointing stick Moves the pointer and selects or activates items on the screen.

(2) Left pointing stick button Functions like the left button on an external mouse.

(3) TouchPad* Moves the pointer and selects or activates items on the screen.

(4) Left TouchPad button* Functions like the left button on an external mouse.

(5) Right pointing stick button Functions like the right button on an external mouse.

(6) TouchPad scroll zone* Scrolls up or down.

(7) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

■ In Windows 7: Select Start > Devices and Printers. Then, right-click the device representing the computer, and select 
Mouse settings.

■ In Windows Vista: Select Start > Control Panel > Hardware and Sound > Mouse.

■ In Windows XP: Select Start > Control Panel > Printers and Other Hardware > Mouse.
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External component identification
Lights

✎ The computer may look slightly different from the illustration in this section.

Item Component Description

(1) Wireless lights (2)* ■ Blue: An integrated wireless device, such as a WLAN device, the 
HP Mobile Broadband Module (select models only), and/or a Bluetooth® 
device, is on.

■ Amber: All wireless devices are off.

(2) Power lights (2)† ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Windows 7 and 
Windows Vista) or Standby (Windows XP).

■ Blinking rapidly: An AC adapter with a higher power rating should be 
connected.

■ Off: The computer is off or in Hibernation.

(3) Battery light ■ Amber: A battery is charging. 

■ Turquoise: A battery is close to full charge capacity. 

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly. 

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level. 

(4) Drive light ■ Blinking turquoise: The hard drive or optical drive is being accessed. 

■ Amber: HP 3D DriveGuard has temporarily parked the internal hard drive, 
and if present, the hard drive in the upgrade bay. 

(5) QuickLook light Turns on briefly when the QuickLook button is pressed.

(6) QuickWeb light Turns on briefly when the QuickWeb button is pressed.

(7) TouchPad light ■ Turquoise: The TouchPad is on.

■ Amber: The TouchPad is off. 

(Continued)
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External component identification
(8) Caps lock light On: Caps lock is on.

(9) Num lock light On: Num lock is on or the embedded numeric keypad is enabled. 

(10) Volume mute light ■ On: Computer sound is on. 

■ Amber: Computer sound is off. 

(11) Volume down light Blinking: The volume down button is being used to decrease the speaker 
volume. 

(12) Volume up light Blinking: The volume up button is being used to increase the speaker volume. 

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open. 
The wireless light on the front of the computer is visible whether the computer is open or closed.

†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The 
power light on the front of the computer is visible whether the computer is open or closed. 

Item Component Description
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External component identification
Front components

Item Component Description

(1) Wireless light ■ Blue: An integrated wireless device, such as a wireless local area network 
(WLAN) device, the HP Mobile Broadband Module, and/ or a Bluetooth® 
device, is on.

■ Amber: All wireless devices are off.

(2) Power light ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Windows 7 and 
Windows Vista) or Standby (Windows XP).

■ Blinking rapidly: An AC adapter with a higher power rating should be 
connected.

■ Off: The computer is off or in Hibernation.

(3) Battery light ■ Amber: A battery is charging. 

■ Turquoise: A battery is close to full charge capacity. 

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly. 

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level. 

(4) Drive light ■ Blinking turquoise: The hard drive or an external optical drive is being 
accessed.

■ Amber: HP 3D DriveGuard has temporarily parked the hard drive, and if 
present, the hard drive in the upgrade bay.

(5) Business card slot Holds a business card in position so that the webcam (select models only) 
can capture an image.

(6) SD Card Reader Supports the optional Secure Digital (SD) Memory Card and MultiMediaCard 
(MMC) digital card formats.

(7) Display release button Opens the computer.

(8) Speakers (2) Produce sound.

(9) Bluetooth compartment Contains a Bluetooth module.
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External component identification
Rear components

Item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3) DisplayPort Connects an optional digital display device such as a high-performance 
monitor or projector.

(4) External monitor port Connects an external VGA monitor or projector.
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External component identification
Right-side components

Left-side components

Item Component Description

(1) Smart card reader Supports optional smart cards and Java™ cards.

(2) Upgrade drive bay Supports an optical drive or a hard drive.

(3) eSATA/USB combo port Connects an optional high-performance eSATA component, such as a 
external mass-storage device, or connects an optional USB device.

(4) RJ-45 (network) jack Connects a network cable.

(5) RJ-11 (modem) jack Connects a modem cable.

Item Component Description

(1) Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(2) USB ports (3) Connects an optional USB devices.

(3) 1394 port Connects an optional IEEE 1394 or 1394a audio/visual device, such as a 
camcorder.

(4) ExpressCard slot Supports optional ExpressCard/54 cards.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio

✎ When a device is connected to the headphone jack, the computer 
speakers are disabled.
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External component identification
Bottom components

Item Component Description

(1) Battery bay Holds the battery.

(2) Battery release latch Releases the battery from the battery bay.

(3) SIM slot (select models only) Contains a wireless subscriber identity module (SIM). The SIM slot is located 
inside the battery bay.

(4) Docking connector Connects an optional docking device.

(5) Accessory battery connector Connects an optional accessory battery.

(6) Vents (7) Enable airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(7) Wireless module compartment Contains a WWAN module (select models only) and/or WLAN module.

Ä To prevent an unresponsive system, replace the wireless module only 
with a wireless module authorized for use in the computer by the 
governmental agency that regulates wireless devices in your country or 
region. If you replace the module and then receive a warning message, 
remove the module to restore computer functionality, and then contact 
technical support through Help and Support.

(8) Business card holder Holds a business card.

(9) Memory module compartment Contains the expansion memory module slot.

(10) Hard drive bay Secures the hard drive.
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Illustrated parts catalog

Serial number location

When ordering parts or requesting information, provide the computer serial number and model number located on 
the bottom of the computer. 

✎ Service tag color varies on select models.

The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial: This is an alphanumeric identifier that is unique to each product.

(3) Product: This number provides specific information about the product's hardware components. The part 
number helps a service technician to determine what components and parts are needed.

(4) Warranty: The number describes the duration of the warranty period for the computer.

(5) Model: This is the number used to locate documents, drivers, and support for the computer.

✎ Warranty and Model fields are excluded from the service tag on select models.
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Illustrated parts catalog
Computer major components
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Illustrated parts catalog
Item Description Spare part number

(1) Display assembly - 14.0-in, antiglare display for use with computer models equipped with 
WLAN and WWAN capability (includes 3 transmit/receive WLAN antenna, 2 transmit/receive 
WWAN antenna, and cables):

14.0-in HD AntiGlare LED SVA (1366x768) for use with HP EliteBook 8440p 594087-001

14.0-in HD AntiGlare LED SVA (1366x768) with webcam for use with HP EliteBook 8440p 594088-001

14.0-in HD+ AntiGlare LED SVA (1600x900) for use with HP EliteBook 8440p 594089-001

14.0-in HD+ AntiGlare LED SVA (1600x900) with webcam for use with HP EliteBook 8440p 594090-001

14.0-in HD AntiGlare LED SVA (1366x768) for use with HP EliteBook 8440w 598210-001

14.0-in HD AntiGlare LED SVA (1366x768) with webcam for use with HP EliteBook 8440w 598211-001

14.0-in HD+ AntiGlare LED SVA (1600x900) for use with HP EliteBook 8440w 598212-001

14.0-in HD+ AntiGlare LED SVA (1600x900) with webcam for use with HP EliteBook 8440w 598213-001

Display assembly subcomponents - See “Display assembly subcomponents” on page 3-8 
for more display assembly subcomponent information.

Display cable 594037-001

Ambient light sensor/connector board 594029-001

Display hinge/bracket (left and right) 594039-001

Display hinge cover (left and right) for use with HP EliteBook 8440p 594038-001

Display hinge cover (left and right) for use with HP EliteBook 8440w 594223-001

Display bezel without webcam lens for HP EliteBook 8440p 594035-001

Display bezel with webcam lens for HP EliteBook 8440p 594036-001

Display bezel without webcam lens for HP EliteBook 8440w 594756-001

Display bezel with webcam lens for HP EliteBook 8440w 594757-001

Display back cover with webcam for use with HP EliteBook 8440p 594031-001

Display back cover with webcam for use with HP EliteBook 8440w 594032-001

Display back cover without webcam for use with HP EliteBook 8440p 594033-001

Display back cover without webcam for use with HP EliteBook 8440w 594034-001

(2) Switch cover 

Switch cover with LED board for use with HP EliteBook 8440p 594095-001

Switch cover with LED board for use with HP EliteBook 8440w 594096-001

(3) Power button board with cable 594025-001

(4) Keyboards (include keyboard cable) 

For use in Brazil 594052-201

For use in Bulgaria 594052-261

For use in Czech Republic 594052-221

For use in Denmark 594052-081

For use in Europe 594052-B31

For use in Europe A4 594052-A41

For use in France 594052-051

For use in French Canada 594052-121

(Continued)
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Illustrated parts catalog
For use in Germany 594052-041

For use in Greece 594052-DJ1

For use in Hungry 594052-211

For use in Iceland 594052-DD1

For use in Israel 594052-BB1

For use in Italy 594052-061

For use in Japan 594052-291

For use in Latin America 594052-161

For use in Norway 594052-091

For use in Portugal 594052-131

For use in Russia 594052-251

For use in Saudi Arabia 594052-171

For use in Slovakia 594052-231

For use in Slovenia 594052-BA1

For use in South Korea 594052-AD1

For use in Spain 594052-071

For use in Sweden/Finland 594052-B71

For use in Switzerland 594052-BG1

For use in Taiwan 594052-AB1

For use in Thailand 594052-281

For use in Turkey 594052-141

For use in United Kingdom 594052-031

For use in United States 594052-001

(5) Fan 594049-001

(6) Heat sink

For use with discrete graphics subsystem 594050-001

For use with Unified Memory Architecture (UMA) graphics subsystem 594051-001

Plastics kit with plastic screw covers, ExpressCard blank, RJ11 plug, and fingerprint reader 
plug not illustrated. See “Plastics kit” on page 3-11 for more Plastics kit information.

594091-001

(7a) ExpressCard slot bezel 

(7b) Hard drive bay cover 

(7c) Memory module compartment cover

(7d) WLAN and WWAN module compartment cover 

(7e) Bluetooth module compartment cover

Cable kit (includes Bluetooth cable and modem cable with RJ11 connector) 594030-001

(8a) Bluetooth module cable. See “Cable kit” on page 3-10 for more Cable kit information. 

(8b) Modem module cable with RJ-11 jack. See “Cable kit” on page 3-10 for more Cable kit 
information. 

(Continued)
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Illustrated parts catalog
(9) Processors (include replacement thermal material) 

Intel® Core™ i5 dual-core processor: 

i5-520M, 2.4-GHz processor (Turbo up to 2.93 GHz) 3-MB L3 cache, 4 threads (35W) 594187-001

i5-540M, 2.53-GHz processor (Turbo up to 3.06 GHz) 3-MB L3 cache, 4 threads (35W) 594188-001

Intel® Core™ i7 quad-core, processor:

i7-620M, 2.66-GHz processor (Turbo up to 3.33 GHz) 6-MB L3 cache, 8 threads (45W) 587259-001

Intel® Core™ i7 quad-core, processor: 

i7-720QM, 1.6-GHz processor (Turbo up to 2.8 GHz), 6-MB L3 cache, 8 threads (45W) 586170-001

i7-820QM, 1.73-GHz processor (Turbo up to 3.06 GHz), 8-MB L3 cache, 8 threads (45W) 583053-001

(10) Primary memory modules (PC3-10600 DDR3 1333-MHz)

1024-MB 598859-001

2048-MB 598856-001

4096-MB 599092-001

(11) RTC battery (includes cable and double-sided tape) 581075-001

(12) Top cover with Touchpad, cable, and bracket

Top cover with smart card reader (13) and fingerprint reader (14) for HP EliteBook 8440p 594098-001

Top cover with smart card reader (13) and fingerprint reader (14) for HP EliteBook 8440w 594099-001

Top cover with smart card reader (13) without fingerprint reader for HP EliteBook 8440w 
(Plastics kit includes fingerprint reader plug)

594100-001

(15) Audio/ExpressCard board 594024-001

(16) System board with replacement thermal material

System board for use with HP EliteBook 8440p discrete graphics subsystem 594026-001

System board for use with HP EliteBook 8440w discrete graphics subsystem 594027-001

System board for use with HP EliteBook 8440p UMA graphics subsystem 594028-001

(17) Speaker assembly 594094-001

(18) Modem module (without cable)

✎ The modem module cable is included in the Cable kit, spare part number 594030-001. 
See “Cable kit” on page 3-10 for more Cable kit information. 

High-speed 56K modem for use in all countries and regions except Australia and New 
Zealand

510099-001

High-speed 56K modem for use in Australia and New Zealand 510099-011

(19) Battery

4 cell, 2.55-Ah (37-Wh) Li-ion battery 489961-001

6 cell, 2.55-Ah (55-Wh) Li-ion battery 486296-001

6 cell, 2.55-Ah (51-Wh) 1000-cycle battery 593578-001

9 cell, 3.0-Ah (100-Wh) Li-ion battery 593579-001

(20) Base enclosure

Base enclosure for use with HP EliteBook 8440p 594021-001

Base enclosure for use with HP EliteBook 8440w 594022-001

(Continued)
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(21) Optical drives (12.7mm SATA) with optical drive bezel and bracket or optional upgrade hard 
drive

Blu-ray ROM DVD±RW SuperMulti DL Drive 594040-001

Blu-ray R/RE DVD±RW SuperMulti Drive 594041-001

DVD-ROM Drive 594042-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 594043-001

(22) Mass storage devices with bracket

250-GB 7200-rpm SATA hard drive 594044-001

320-GB 7200-rpm SATA hard drive 594045-001

500-GB 7200-rpm SATA hard drive (also used for optional upgrade bay hard drive) 594046-001

160-GB solid-state drive 594047-001

256-GB solid-state drive 594048-001

(23) Expansion memory modules (PC3-10600 DDR3 1333-MHz)

1024-MB 598859-001

2048-MB 598856-001

4096-MB 599092-001

(24) WLAN modules 

Intel a/g/n (2x2) for use in all countries and regions 572509-001

Intel a/g/n (3x3) for use in all countries and regions 572511-001

Intel a/b/g for use in Russia 572510-001

Broadcom BCM4312 802.11b/g WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

(Continued)
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Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, 

Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azer-

baijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Ber-

muda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, 

Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central 

African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the 

Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecua-

dor, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, 

French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, 

Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, 

Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, 

Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 

Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, 

the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, 

Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, 

Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Nor-

way, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic 

of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, 

Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Ser-

bia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, 

Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vin-

cent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajiki-

stan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, 

Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbeki-

stan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

(25) WWAN Modules

Qualcomm EV-DO HSPA minicard 531993-001

Ericsson F3607 SDG 900 HSPA minicard 574249-001

(26) Bluetooth module (without cable)

✎ The Bluetooth module cable is included in the Cable kit, spare part number 
594030-001. See “Cable kit” on page 3-10 for more Cable kit information. 

537921-001

Item Description Spare part number
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Display assembly subcomponents

Item Description Spare part number 

(1) Display bezel

Bezel with webcam lens for HP EliteBook 8440w Mobile Workstation 594757-001

Bezel without webcam lens for HP EliteBook 8440w Mobile Workstation 594756-001

Bezel with webcam lens for HP EliteBook 8440p Notebook PC 594036-001

Bezel without webcam lens for HP EliteBook 8440p Notebook PC 594035-001

(2) Display panel

(3) Display cable 594037-001

(4) Display hinge/bracket (left and right) 594039-001

Hinge cap (left and right) for HP EliteBook 8440w Mobile Workstation 594223-001

Hinge cap (left and right) for HP EliteBook 8440p Notebook PC 594038-001

(5) Ambient light sensor/connector board 594029-001

(Continued)
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(6) Back cover includes the dual-array microphone and cable, wireless antennas and 
cables

Back cover with webcam for HP EliteBook 8440w Mobile Workstation 594032-001

Back cover without webcam for HP EliteBook 8440w Mobile Workstation 594034-001

Back cover with webcam for HP EliteBook 8440p Notebook PC 594031-001

Back cover without webcam for HP EliteBook 8440p Notebook PC 594033-001
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Cable kit

Item Description Spare part number 

Cable kit: 594030-001

(1) Modem module cable (includes RJ-11 jack) 

(2) Bluetooth module cable
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Plastics kit

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Item Description Spare part number 

Plastics kit: 594091-001

(1) ExpressCard slot bezel 

(2) Hard drive bay cover (includes one captive screw, secured by a C-clip)

(3) Wireless module compartment cover (includes one captive screw) 

(4) Expansion memory compartment cover

(5) Bluetooth module compartment cover
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Mass storage devices

Item Description Spare part number 

(1) Hard drives (includes bracket, screws, and sponge material)

250-GB 7200-rpm SATA hard drive 594044-001

320-GB 7200-rpm SATA hard drive 594045-001

500-GB 7200-rpm SATA hard drive 594046-001

(2) Optical drives (includes drive bezel, bracket, and rubber covers)

Blu-ray ROM with LightScribe DVD±RW SuperMulti DL Drive 594040-001

Blu-ray R/RE DVD±RW SuperMulti Drive 594041-001

DVD-ROM Drive 594042-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 594043-001

(3) Solid-state drives

160-GB solid-state drive 594047-001

256-GB solid-state drive 594048-001
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Miscellaneous parts

Description Spare part number 

Rubber kit with rubber screw covers for upgrade-bay, top cover back, display screw covers, 
base enclosure screw covers, and rubber feet

594092-001

AC adapter 

90W AC adapter 463955-001

90W AC adapter for use in India 535593-001

65W AC adapter 463958-001

65W AC adapter for use in India 577170-001

Power cords: 

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the People's Republic of China 490371-AA1

For use in the United Kingdom and Singapore 490371-031

Thermal heatshield (includes thermal support items) 594097-001

CPU Mylar (processor support item) 598214-001

Screw kit (includes 15 of each of the following screws)
Phillips PM2.0×2.0×7.0 (broad-head)
Phillips PM2.0×3.0×4.5
Phillips PM2.0×4.0×4.5
Phillips PM2.5×3.0×4.5
Phillips PM2.5×4.0×4.5
Phillips PM 2.5×5.0×4.5
Torx T8 M 2.5×6.0×5.0
Phillips PM2.8×4.0×5.0
Phillips PM3.0×3.0×5.0

594093-001
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Sequential part number listing

Spare part number Description

463955-001 90W AC adapter 

463958-001 65W AC adapter

486296-001 Battery 6 cell, 2.55-Ah (55-Wh) Li-ion 

489961-001 Battery 4 cell, 2.55-Ah (37-Wh) Li-ion 

490371-001 Power cord for use in North America

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe

490371-031 Power cord for use in the United Kingdom and Singapore

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-202 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

504593-003 Broadcom BCM4312 802.11b/g WLAN module for use in Canada, the Cayman 
Islands, Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

(Continued)
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504593-004 Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, 
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, 
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, 
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, the 
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New 
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua 
New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, 
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San 
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra 
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the 
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, 
Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, 
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

510099-001 High-speed 56K modem for use in all countries and regions except Australia and New 
Zealand

510099-011 High-speed 56K modem for use in Australia and New Zealand

531993-001 Qualcomm EV-DO HSPA WWAN module

535593-001 90W AC adapter for use in India

537921-001 Bluetooth module without cable

572509-001 Intel a/g/n (2 x 2) WLAN module

572510-001 Intel a/b/g WLAN module for use in Europe, Middle-East, and Africa

572511-001 Intel a/g/n (3 x 3) WLAN module

574249-001 Ericsson F3607 SDG 900 HSPA WWAN module

577170-001 65W AC adapter for use in India

581075-001 RTC battery 

583053-001 i7-820QM, 1.73-GHz Intel® Core™ i7 quad-core processor Turbo up to 3.06 GHz), 
8-MB L3 cache, 8 threads (45W)

586170-001 i7-720QM, 1.6-GHz Intel® Core™ i7 quad-core processor (Turbo up to 2.8 GHz), 6-MB 
L3 cache, 8 threads (45W) 

587259-001 i7-620M, 2.66-GHz Intel® Core™ i7 quad-core processor (Turbo up to 3.33 GHz), 
6-MB L3 cache, 8 threads (45W)

593578-001 6 cell, 2.55-Ah (51-Wh) 1000-cycle battery

593579-001 9 cell, 3.0-Ah (100-Wh) Li-ion battery 

594021-001 Base enclosure for use with HP EliteBook 8440p

594022-001 Base enclosure for use with HP EliteBook 8440w

594024-001 Audio/ExpressCard board

(Continued)
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594025-001 Power button board with cable

594026-001 System board for use with HP EliteBook 8440p discrete graphics subsystem

594027-001 System board for use with HP EliteBook 8440w discrete graphics subsystem

594028-001 System board for use with HP EliteBook 8440p UMA graphics subsystem

594029-001 Ambient light sensor/connector board

594030-001 Cable kit (includes Bluetooth cable and modem cable with RJ11 connector)

594031-001 Display back cover with webcam for use with HP EliteBook 8440p 

594032-001 Display back cover with webcam for use with HP EliteBook 8440w

594033-001 Display back cover without webcam for use with HP EliteBook 8440p

594034-001 Display back cover without webcam for use with HP EliteBook 8440w

594035-001 Display bezel without webcam lens for HP EliteBook 8440p

594036-001 Display bezel with webcam lens for HP EliteBook 8440p

594037-001 Display cable

594038-001 Display hinge cover (left and right) for use with HP EliteBook 8440p

594039-001 Display hinge/bracket (left and right)

594040-001 Blu-ray ROM with LightScribe DVD±RW SuperMulti DL Drive (12.7mm SATA) with 
bezel and bracket

594041-001 Blu-ray R/RE DVD±RW SuperMulti Drive (12.7mm SATA) with bezel and bracket

594042-001 DVD-ROM Drive (12.7mm SATA) with bezel and bracket

594043-001 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 
(12.7mm SATA) with bezel and bracket

594044-001 250-GB 7200-rpm SATA hard drive 

594045-001 320-GB 7200-rpm SATA hard drive 

594046-001 500-GB 7200-rpm SATA hard drive 

594047-001 160-GB solid-state drive

594048-001 256-GB solid-state drive

594049-001 Fan

594050-001 Heat sink for use with discrete graphics subsystem

594051-001 Heat sink for use with Unified Memory Architecture (UMA) graphics subsystem

594052-001 Keyboard for use in United States

594052-031 Keyboard for use in United Kingdom

594052-041 Keyboard for use in Germany

594052-051 Keyboard for use in France

594052-061 Keyboard for use in Italy

594052-071 Keyboard for use in Spain

594052-081 Keyboard for use in Denmark

594052-091 Keyboard for use in Norway

594052-121 Keyboard for use in French Canada 

594052-131 Keyboard for use in Portugal

594052-141 Keyboard for use in Turkey

(Continued)
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594052-161 Keyboard for use in Latin America

594052-171 Keyboard for use in Saudi Arabia 

594052-201 Keyboard for use in Brazil

594052-211 Keyboard for use in Hungry

594052-221 Keyboard for use in Czech Republic

594052-231 Keyboard for use in Slovakia

594052-251 Keyboard for use in Russia

594052-261 Keyboard for use in Bulgaria 

594052-281 Keyboard for use in Thailand

594052-291 Keyboard for use in Japan 

594052-A41 Keyboard for use in Europe A4

594052-AB1 Keyboard for use in Taiwan

594052-AD1 Keyboard for use in South Korea

594052-B31 Keyboard for use in Europe

594052-B71 Keyboard for use in Sweden/Finland

594052-BA1 Keyboard for use in Slovenia

594052-BB1 Keyboard for use in Israel 

594052-BG1 Keyboard for use in Switzerland

594052-DD1 Keyboard for use in Iceland

594052-DJ1 Keyboard for use in Greece

594087-001 Display assembly, 14.0-in, HD AntiGlare LED SVA (1366 x 768)

594088-001 Display assembly, 14.0-in, HD AntiGlare LED SVA (1366 x 768) with webcam

594089-001 Display assembly, 14.0-in, HD+ AntiGlare LED SVA (1600 x 900)

594090-001 Display assembly, 14.0-in, HD+ AntiGlare LED SVA (1600 x 900) with webcam

594091-001 Plastics kit with plastic screw covers, ExpressCard blank, RJ11 plug, and fingerprint 
reader plug

594092-001 Rubber kit with rubber screw covers for upgrade-bay, top cover back, LCD screw 
covers, base enslosure, and rubber feet

594093-001 Screw kit (includes 15 of each of the following screws)
Phillips PM2.0×2.0×7.0 (broad-head)
Phillips PM2.0×3.0×4.5
Phillips PM2.0×4.0×4.5
Phillips PM2.5×3.0×4.5
Phillips PM2.5×4.0×4.5
Phillips PM2.5×5.0×4.5
Torx T8 M2.5×6.0×5.0
Phillips PM2.8×4.0×5.0
Phillips PM3.0×3.0×5.0

594094-001 Speaker assembly

594095-001 Switch cover with LEB board for use with HP EliteBook 8440p

594096-001 Switch cover with LED board for use with HP EliteBook 8440w

594097-001 Thermal heatshield (includes thermal support items)

(Continued)
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594098-001 Top cover with integrated Touchpad, smart card reader, and fingerprint reader for use 
with HP EliteBook 8440p

594099-001 Top cover with integrated Touchpad, smart card reader, and fingerprint reader for use 
with HP EliteBook 8440w

594100-001 Top cover with integrated Touchpad, smart card reader, and without fingerprint reader 
for use with HP EliteBook 8440w 

594187-001 i5-520M, 2.4-GHz Intel® Core™ i5 dual-core processor, (Turbo up to 2.93 GHz), 3-MB 
L3 cache, 4 threads (35W)

594188-001 i5-540M, 2.53-GHz Intel® Core™ i5 dual-core processor, (Turbo up to 3.06 GHz), 
3-MB L3 cache, 4 threads (35W)

594223-001 Display hinge cover (left and right) for use with HP EliteBook 8440w 

594756-001 Display bezel without webcam lens for HP EliteBook 8440w

594757-001 Display bezel with webcam lens for HP EliteBook 8440w

598210-001 14.0 HD AntiGlare LED SVA (1366x768) or use with HP EliteBook 8440w

598211-001 14.0 HD AntiGlare LED SVA (1366x768) with webcam or use with HP EliteBook 8440w

598212-001 14.0 HD+ AntiGlare LED SVA (1600x900) or use with HP EliteBook 8440w

598213-001 14.0 HD+ AntiGlare LED SVA (1600x900) with webcam or use with HP EliteBook 
8440w

598214-001 CPU Mylar (processor support item)

598859-001 1024-MB memory module (PC3-10600 DDR3 1333-MHz)

598856-001 2048-MB memory module (PC3-10600 DDR3 1333-MHz)

599092-001 4096-MB memory module (PC3-10600 DDR3 1333-MHz)
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Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures: 

■ Flat-bladed screwdriver

■ Phillips P0

■ Phillips P1 screwdriver

■ Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and 
assembly procedures. 

✎ As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) 
away from the work area to prevent damage. 

Plastic parts

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

Ä
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly 
process. Improper cable placement can damage the computer. 

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the 
cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or 
snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily. 
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Drive handling

ÄCAUTION: Drives are fragile components that must be handled with care. To prevent damage to the computer, 
damage to a drive, or loss of information, observe these precautions:
■ Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off 

or in Hibernation, turn the computer on, and then shut it down through the operating system. 
■ Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid 

touching the connector.
■ Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure 

that the optical drive tray is closed.
■ Handle drives on surfaces covered with at least one inch of shock-proof foam. 
■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers. 
■ Avoid exposing a drive to temperature extremes or liquids. 
■ If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging 

and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD 
contains enough power to alter device parameters or melt silicon junctions. 

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred. 

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. 
Or, the device may function normally for a while, and then degrade in the internal layers, reducing its life 
expectancy. 

ÄCAUTION: To prevent damage to the computer when you are removing or installing internal components, observe 
these precautions:
■ Keep components in their electrostatic-safe containers until you are ready to install them.
■ Use nonmagnetic tools. 
■ Before touching an electronic component, discharge static electricity by using the guidelines described in 

this section.
■ Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
■ If you remove a component, place it in an electrostatic-safe container.
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The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

ÄCAUTION: A product can be degraded by as little as 700 V. 

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment: 

■ To avoid hand contact, transport products in static-safe tubes, bags, or boxes. 

■ Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging. 

■ Keep ESD-sensitive parts in their containers until they arrive at static-free workstations. 

■ Place items on a grounded surface before them from their containers. 

■ Always be properly grounded when touching a component or assembly. 

■ Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam. 

■ Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment 
used for moving materials is wired to ground, and that proper materials are selected to avoid static charging. 
When grounding is not possible, use an ionizer to dissipate electric charges. 

Typical electrostatic voltage levels 

Relative humidity 

Event 10% 40% 55% 

Walking across carpet 35,000 V 15,000 V 7,500 V 

Walking across vinyl floor 12,000 V 5,000 V 3,000 V 

Motions of bench worker 6,000 V 800 V 400 V 

Removing DIPS from plastic tube 2,000 V 700 V 400 V 

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V 

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V 

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V 

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V 
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Workstation guidelines

Follow these workstation grounding guidelines: 

■ Cover the workstation with approved static-shielding material. 

■ Use a wrist strap connected to a properly grounded work surface, and use properly grounded tools and 
equipment. 

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums. 

■ When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials. 

■ Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam. 

■ Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items 
only at static-free workstations. 

■ Avoid contact with pins, leads, or circuitry. 

■ Turn off power and input signals before inserting or removing connectors or test equipment. 

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation. 

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly 
against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a 
wrist strap. 

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at 
standing workstations and are compatible with most types of shoes or boots. On conductive floors or 
dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the 
operator and ground. To be effective, the conductive strips must be worn in contact with the skin. 

The following grounding equipment is recommended to prevent electrostatic damage: 

■ Antistatic tape 

■ Antistatic smocks, aprons, and sleeve protectors 

■ Conductive bins and other assembly or soldering aids 

■ Nonconductive foam 

■ Conductive tabletop workstations with ground cords of one megohm resistance 

■ Static-dissipative tables or floor mats with hard ties to the ground 

■ Field service kits 

■ Static awareness labels 

■ Material-handling packages 

■ Nonconductive plastic bags, tubes, or boxes 

■ Metal tote boxes 

■ Electrostatic voltage levels and protective materials 

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level 

Antistatic plastic Bags 1,500 V 

Carbon-loaded plastic Floor mats 7,500 V 

Metallized laminate Floor mats 5,000 V 
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Component replacement procedures

This chapter provides removal and replacement procedures. 

There are as many as 67 screws, in 9 different sizes, that must be removed, replaced, or loosened when servicing 
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag (see Serial number location).

✎ Service tag color varies on select models.

✎ Warranty and Model fields are excluded from the service tag on select models.

Item Field Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial This is an alphanumeric identifier that is unique to each product.

(3) Product This number provides specific information about the product’s hardware components. The 
product number, or part number, helps a service technician determine what components and 
parts are needed.

(4) Warranty This number describes the duration of the warranty period for the computer.

(5) Model This is the alphanumeric identifier used to locate documents, drivers, and support for the 
computer.
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Computer feet

The computer feet are part of the base enclosure. The feet are included in the Rubber Kit, spare part number 
594092-001. There are 5 rubber feet that attach to the base enclosure in the locations shown in the following 
illustration. 
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Battery

Before removing the battery, follow these steps:

» Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you. 

2. Slide the battery release latch 1 to release the battery. 

3. Remove the battery 2.

Install the battery by inserting it into the battery bay until you hear a click. 

Description Spare part number

4 cell, 2.55-Ah (37-Wh) Li-ion battery 489961-001

6 cell, 2.55-Ah (55-Wh) Li-ion battery 486296-001

6 cell, 2.55-Ah (51-Wh) 1000-cycle battery 593578-001

9 cell, 3.0-Ah (100-Wh) Li-ion battery 593579-001
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SIM

✎ The end user supplies the SIM, which stores the service-subscriber key to identify the subscriber on a wireless 
wide-area network (WWAN). The SIM should be removed, stored in static-safe container, and replaced when 
reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7). 

Remove the SIM:

1. Push on the SIM 1 to release it from the SIM slot.

2. Remove the SIM 2 from the computer.

Install the SIM by inserting it into the SIM slot and pushing until you hear a click. 

Ä
CAUTION: When inserting a SIM, position the card with the slanted corner as shown in the illustration. If a SIM is inserted 
backwards or upside down, the battery may not snap into place properly and could damage the SIM and the SIM connector.

To prevent damage to the connectors, use minimal force when inserting a SIM.
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Hard drive

✎ The hard drive spare part kit includes drive bracket, screws, and sponge material.

Before removing the hard drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the 2 Phillips PM2.0×5.0 captive screws 1 that secure the hard drive cover to the computer. 

3. Lift the left side 2 of the hard drive bay cover to detach it from the computer.

4. Remove the hard drive bay cover. The cover is included in the Plastics Kit, spare part number 594091-001.

Description Spare part number

250-GB 7200-rpm SATA hard drive 594044-001

320-GB 7200-rpm SATA hard drive 594045-001

500-GB 7200-rpm SATA hard drive 594046-001

160-GB solid-state drive 594047-001

256-GB solid-state drive 594048-001
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5. Loosen the Phillips PM2.5×10.0 captive screw 1 that secures the hard drive to the computer.

6. Grasp the Mylar tab 2 on the top of the hard drive, and then lift it up and to the right to disconnect the hard 
drive from the hard drive connector on the system board.

7. Remove the hard drive 3 from the hard drive bay. 

8. To replace the hard drive bracket, follow these steps:

a. Remove the 4 Phillips PM3.0×3.0 screws 1 that secure the hard drive bracket to the hard drive.

b. Lift the bracket straight up 2 to remove it from the hard drive. 

Reverse this procedure to reassemble and install the hard drive. 
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WLAN module

Before removing the WLAN module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Description Spare part number

Broadcom BCM4312 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 

Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Baha-

mas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, 

Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina 

Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, 

Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Domin-

ica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, 

Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, 

Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Hon-

duras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, 

Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 

Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the 

Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, 

Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 

the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, 

Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portu-

gal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and 

Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slove-

nia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, 

St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Tai-

wan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmeni-

stan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 

Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

Intel a/g/n (2x2) for use in all countries and regions 572509-001

Intel a/g/n (3x3) for use in all countries and regions 572511-001

Intel a/b/g for use in Russia 572510-001
Maintenance and Service Guide 4–11



Removal and replacement procedures
Remove the WLAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer upside down, with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw 1 that secures the wireless module compartment cover to 
the computer.

3. Lift the left side of the cover 2 to remove it from the computer.

The wireless module compartment cover is included in the Plastics Kit, spare part number 594091-001.
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4. Disconnect the WLAN antenna cables 1 from the terminals on the WLAN module.

✎The antenna cables are labeled: 1 - black, 2 - white, and 3 - yellow. Connect the antenna cables to the 
matching transmit/receive connector on the WLAN module. 

5. Remove the 2 Phillips PM2.5×4.0 screws 2 that secure the WLAN module to the computer. 

6. Remove the WLAN module 3 by pulling it away from the slot at an angle. 

✎WLAN modules are designed with a notch 4 to prevent incorrect insertion of the WLAN module into 
the WLAN module slot.

Reverse this procedure to install the WLAN module.
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WWAN module

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

Remove the wireless module compartment cover. 

1. Position the computer upside down, with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw 1 that secures the wireless module compartment cover to 
the computer.

3. Lift the left side of the cover 2 to remove it from the computer.

The wireless module compartment cover is included in the Plastics Kit, spare part number 594091-001.

Description Spare part number

Ericsson F3607 SDG 900 HSPA minicard 574249-001

Qualcomm Evolution-Data only (EVDO)/High-speed packet access (HSPA) minicard 531993-001
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Remove the WWAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the 
computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and 
then receive a warning message, remove the module to restore computer functionality, and then contact technical support through 
Help and Support.

1. Position the computer upside down, with the front toward you.

2. Disconnect the WWAN antenna cables 1 from the terminals on the WWAN module.

✎The WWAN antenna cables are labeled: 5 - red, and 6 - blue. Connect the antenna cables to the matching 
transmit/receive connector on the WWAN module. 

3. Remove the 2 Phillips PM2.5×4.0 screws 2 that secure the WWAN module to the computer. The WWAN 
module tilts up with the screws removed.

4. Remove the WWAN module 3 by pulling it away from the slot at an angle. 

✎WWAN modules are designed with a notch 4 to prevent incorrect insertion of the WWAN module into 
the WWAN module slot.

Reverse this procedure to install the WWAN module. 
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Memory module

Expansion memory module

Before removing the expansion memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

Remove the expansion memory module compartment cover.

1. Position the computer upside down, with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw 1 that secures the memory compartment cover to the computer.

3. Lift the left side of the cover 2 to remove it from the computer.

The memory module compartment cover is included in the plastics kit, spare part number 594091-001.

Description Spare part number

4096-MB memory module (PC3-10600 DDR3 1333-MHz) 599092-001

2048-MB memory module (PC3-10600 DDR3 1333-MHz) 598856-001

1024-MB memory module (PC3-10600 DDR3 1333-MHz) 598859-001
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Remove the expansion memory module:

✎ The expansion memory module is accessed from the bottom of the computer; the primary memory module is 
under the keyboard.

1. Pull away the retention clips 1 on each side of the memory module to release the memory module. (The 
memory module tilts up.)

Ä
CAUTION: The memory module is electrostatic sensitive. To prevent damage to the memory module, hold it by the card edge, 
do not touch components, and follow “Workstation guidelines” on page 4-4.

2. Grasp the edge of the memory module 2, and then remove it from the memory module slot.

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory module 
slot.

Reverse this procedure to install an expansion memory module.
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Primary memory module

Before removing the primary memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

Open the keyboard:

1. Position the computer upside down, with the front toward you.

2. Loosen the 3 Phillips PM2.5×10.0 captive screws that secure the keyboard to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the 4 keyboard latches.
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6. Lift the rear edge of the keyboard and slide the keyboard back until it rests on the switch cover and display.

Remove the primary memory module:

✎ Primary memory is under the keyboard. Expansion memory is in the expansion memory compartment on the 
bottom of the computer.

1. Pull away the retention clips 1 on each side of the memory module to release the memory module. (The 
memory module tilts up.)

Ä
CAUTION: The memory module is electrostatic sensitive. To prevent damage to the memory module, hold it by the card edge, 
do not touch components, and follow “Workstation guidelines” on page 4-4.

2. Grasp the edge of the memory module 2, and then remove it from the memory module slot.

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory module 
slot.

Reverse this procedure to install a primary memory module.
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Optical drive

✎ The optical drive spare part kit includes an optical drive bezel, bracket, and rubber covers.

Before removing the optical drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Remove the optical drive:

1. Remove the Phillips PM2.5×10.0 screw 1 that secures the optical drive to the computer.

2. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access 2, and then press the tab to the 
left to release the optical drive from the computer.

3. Remove the optical drive 3 from the optical drive bay.

Description Spare part number

Blu-ray R/RE DVD±RW SuperMulti Drive 594041-001

Blu-ray ROM with LightScribe DVD±RW SuperMulti DL Drive 594040-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 594043-001

DVD-ROM Drive 594042-001
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4. If it is necessary to replace the optical drive bracket, follow these steps:

a. Position the optical drive with the rear toward you. 

b. Remove the 3 Phillips PM2.0×4.0 screws 1 that secure the optical drive bracket to the optical drive. 

c. Remove the optical drive bracket 2. 

Reverse this procedure to reassemble and install an optical drive. 
Maintenance and Service Guide 4–21



Removal and replacement procedures
Keyboard and switch cover

✎ The switch cover spare part kit includes an LED board and cable.

✎ The keyboard spare part kit includes a keyboard cable.

Before removing the keyboard and switch cover, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Description Spare part number

Switch cover for use with HP EliteBook 8440p 594095-001

Switch cover for use with HP EliteBook 8440w 594096-001

Keyboard for use in country 
or region: Spare part number

Keyboard for use in country 
or region: Spare part number

Brazil 594052-201 Norway 594052-091

Bulgaria 594052-261 Portugal 594052-131

Czech Republic 594052-221 Russia 594052-251

Denmark 594052-081 Saudi Arabia 594052-171

Europe 594052-B31 Slovakia 594052-231

Europe A4 594052-A41 Slovenia 594052-BA1

France 594052-051 South Korea 594052-AD1

French Canada 594052-121 Spain 594052-071

Germany 594052-041 Sweden/Finland 594052-B71

Greece 594052-DJ1 Switzerland 594052-BG1

Hungry 594052-211 Taiwan 594052-AB1

Iceland 594052-DD1 Thailand 594052-281

Israel 594052-BB1 Turkey 594052-141

Italy 594052-061 United Kingdom 594052-031

Japan 594052-291 United States 594052-001

Latin America 594052-161
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Remove the keyboard and switch cover:

1. Position the computer with the front toward you.

2. Remove the following:

❏ Two rubber screw covers 1 and 2 Torx T8 M2.5×6.0 screws 2 that secure the switch cover to the computer

❏ Three Phillips PM2.0×2.0 broadhead screws 3 that secure the switch cover to the computer in the battery 
bay

✎Use the Phillips P0 screwdriver to remove the PM2.0×2.0 broadhead screws.

❏ Three PM2.5×10.0 captive screws that secure the keyboard to the computer

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.
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5. Release the 4 keyboard latches 1.

6. Lift the rear edge 2 of the keyboard until it rests at an angle, and then turn the keyboard over until it rests on 
the front of the top cover.

7. Release the zero insertion force (ZIF) connectors to which the pointing stick cable 1 and the keyboard cable 2 
is attached, and then disconnect the cables from the system board.

8. Remove the keyboard.
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9. Release the ZIF connector to which the LED board cable 1 is attached, and then disconnect the LED board 
cable from the system board.

10. Lift the back edge of the switch cover 2 and release it from the computer.

11. Remove the switch cover.

Reverse this procedure to install the keyboard and switch cover.
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Power button board

✎ The power button board spare part kit includes the cable.

Before removing the power button board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

Remove the power button board:

1. Turn the switch cover over, with the front toward you.

2. Release the ZIF connector to which the power button board cable 1 connects to the LED board, and then 
disconnect the cable from the LED board.

3. Remove the Phillips PM2.0×3.0 2 screw from the power button board.

4. Remove the power button board and cable 3.

Reverse this procedure to install the power button board.

Description Spare part number

Power button board 594025-001
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Display assembly

✎ The display assembly spare part kit includes 3 transmit/receive WLAN antennas, 2 transmit/receive WWAN 
antennas, the cables, and the nameplate.

Description Spare part number

14.0-in LED display assembly for use with WLAN and WWAN (includes 3 transmit/receive WLAN antennas, 2 transmit/receive 
WWAN antennas, and the cables):

■ 14.0-in HD Antiglare LED SVA (1366 x 768 resolution) for use with HP EliteBook 8440p 594087-001

■ 14.0-in HD Antiglare LED SVA (1366 x 768) with webcam for use with HP EliteBook 8440p 594088-001

■ 14.0-in HD+ Antiglare LED SVA (1600 x 900) for use with HP EliteBook 8440p 594089-001

■ 14.0-in HD+ Antiglare LED SVA (1600 x 900) with webcam for use with HP EliteBook 8440p 594090-001

■ 14.0-in HD AntiGlare LED SVA (1366 x 768) for use with HP EliteBook 8440w 598210-001

■ 14.0-in HD AntiGlare LED SVA (1366 x 768) with webcam for use with HP EliteBook 8440w 598211-001

■ 14.0-in HD+ AntiGlare LED SVA (1600 x 900) for use with HP EliteBook 8440w 598212-001

■ 14.0-in HD+ AntiGlare LED SVA (1600 x 900) with webcam for use with HP EliteBook 8440w 598213-001

Display assembly subcomponents 

■ Display cable 594037-001

■ Ambient light sensor/connector board 594029-001

■ Display hinge/bracket 594039-001

■ Display hinge covers for use with HP EliteBook 8440p 594038-001

■ Display hinge covers for use with HP EliteBook 8440w 594223-001

Display bezel

■ Display bezel without webcam lens for HP EliteBook 8440p 594035-001

■ Display bezel with webcam lens for HP EliteBook 8440p 594036-001

■ Display bezel without webcam lens for HP EliteBook 8440w 594756-001

■ Display bezel with webcam lens for HP EliteBook 8440w 594757-001

Display back cover

✎ The display back cover includes the dual-array microphone, wireless antennas, and 
associated cables, and on models that use a webcam, the webcam and webcam cable. 

■ Display back cover with webcam for HP EliteBook 8440p 594031-001

■ Display back cover with webcam for HP EliteBook 8440w 594032-001

■ Display back cover without webcam for HP EliteBook 8440p 594033-001

■ Display back cover without webcam for HP EliteBook 8440w 594034-001

■ Display back cover without webcam for HP EliteBook 8440w 577188-001
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Before removing the display assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Disconnect the wireless antenna cables from the WLAN module (see “WLAN module” on page 4-11) and 
WWAN module (see “WWAN module” on page 4-14).

6. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-22).
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Remove the display assembly:

1. Turn the computer right side up, with the front toward you.

2. Open the computer.

3. Remove the wireless antenna cables 1 from the opening, clips, and routing channel 2 on the top cover.

✎When installing the display assembly, be sure to route the wireless antenna cables through the cable channel. The 
wireless antenna cables have exposed shields that contact a grounding pad on the top cover. Failure to make proper 
contact can result in degraded performance.

4. Disconnect to microphone cable 1 from the system board.

5. Remove the microphone cable from the clips and channel 2 built into the top cover.

6. Disconnect the display cable 3 from the system board, and then remove the display cable.
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ÄCAUTION: Support the display assembly when removing the following screws. Failure to support the display 
assembly can result in damage to the display assembly and other computer components.

7. Remove the two rubber screw covers 1 and two Torx T8M2.5×6.0 screws 2 that secure the display assembly 
to the back of the computer.

8. Remove the two Torx T8M2.5×6.0 screws 3 that secure the display assembly to the bottom of the computer.

9. Turn the computer right-side up and open the display.

10. Remove the two Torx T8M2.5×6.0 screws 1 that secure the display assembly hinges to the base enclosure.

11. Lift the display assembly 2 straight up and remove it.
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12. If it is necessary to replace the display bezel or any of the display assembly subcomponents, follow these steps:

a. Remove the four rubber screw covers 1 and the four Torx T8M2.5×6.0 screws 2 that secure the display 
bezel to the display assembly.

b. Flex the top inside edge 1, the left and right inside edges 2, and the bottom inside edge 3 of the display 
bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel 4. The display bezel is available using the following spare part numbers:

◆ 594036-001 - Display bezel for use on HP EliteBook 8440p equipped with a webcam

◆ 594035-001 - Display bezel for use on HP EliteBook 8440p not equipped with webcam

◆ 594757-001 - Display bezel for use on HP EliteBook 8440w equipped with a webcam

◆ 594756-001 - Display bezel for use on HP EliteBook 8440w not equipped with webcam
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13. If it is necessary to replace the display hinges:

a. Remove the four Phillips PM2.5×5.0 screws that secure the display panel to the display back cover.

b. Remove the display panel cable 1 from the ambient light sensor/connector board and clips 2 in the display 
back cover.

c. Remove the display panel 3.
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Removal and replacement procedures
d. Remove 6 Phillips PM2.5×3.0 screws 1 that secure the display hinges to the display panel. The display 
hinge set is available as spare part number 594039-001.

e. Remove the display hinges 2.

14. If it is necessary to replace the display hinge covers:

a. Loosen the PM2.5×3.0 screws 1 that hold the display hinge covers in place.

b. Slide the display hinge covers off 2 the display hinges.
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15. If it is necessary to replace the display cable:

a. Turn the display panel upside down, with the top edge toward you.

b. Fold back the adhesive strip 1 that covers the display cable connector.

c. Release the support bar 2 that secures the display cable to the display panel.

d. Disconnect the display cable 3 from display panel connector. The display cable is available using spare part 
number 594037-001.

16. If necessary to replace the webcam module and cables, the dual-array microphone and microphone cable, or 
the wireless antennas and cables, replace the display back cover using the following part numbers:

❏ 594031-001 - Display back cover for use on EliteBook 8440p equipped with a webcam

❏ 594032-001 - Display back cover for use on EliteBook 8440w equipped with a webcam

❏ 594033-001 - Display back cover for use on EliteBook 8440p not equipped with a webcam

❏ 594034-001 - Display back cover for use on EliteBook 8440w not equipped with a webcam

✎The back cover spares that come with or without the webcam include the WLAN and WWAN antenna 
cables 1, WLAN and WWAN antenna 2, webcam cable 3 (with webcam), keyboard light and cable 4, 
and the dual-array microphone and cable 5.

Reverse this procedure to install the display assembly.
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Fan and heat sink

✎ The fan and heat sink spare part kits include replacement thermal material.

✎ To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of the computer. The 
computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to 
turn on when high temperature conditions exist. These conditions are affected by high external temperatures, 
system power consumption, power management/battery conservation configurations, battery fast charging, and 
software requirements. Exhaust air is displaced through the ventilation grill located on the left side of the 
computer. 

Before removing the fan and heat sink, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-22).

Description Spare part number

Fan 594049-001

Heat sink for use on computer models equipped with a graphics subsystem using discrete memory 594050-001

Heat sink for use on computer models equipped with a graphics subsystem using UMA memory 594051-001
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Remove the fan:

1. Disconnect the fan cable 1 from the system board.

2. Remove the Mylar strip 2 taped between the fan and the heat sink.

3. Remove the two Torx T8M2.5×6.0 screws 3 that secure the fan to the system board.

4. Lift straight up to remove the fan assembly 4. 
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Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the 4 Phillips PM2.5×10.0 spring-loaded 
captive screws 1 that secure the heat sink to the system board.

2. Pull the heat sink up 2 and away 3 from the ventilation grill. If necessary, move the heat sink side-to-side to 
release the heat sink from the thermal material.

✎The first illustration below shows the heat sink on computer models that use the discrete graphics subsystem. The 
second illustration shows the heat sink on computer models that use the UMA graphics subsystem.

3. Remove the heat sink assembly.
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Replace the thermal material:

The thermal material must be cleaned from the surfaces of the heat sink and the system board each time the heat 
sink is removed. Replacement thermal material is included with fan, heat sink, and heat shield spare parts.

■ Thermal paste is used between the processor 1 and the heat sink section 2 that services it.

■ Thermal pads are used between the system board capacitors 3 and the heat sink section 4 that services it.

■ Thermal pads are used on the graphics subsystem memory module 5 and the heat sink section 6 that 
services it.

✎The first illustration shows thermal material locations on computer models that use the discrete graphics 
subsystem. The second illustration shows the thermal material locations on computer models that use the UMA 
graphics subsystem.

Reverse this procedure to install the fan and heat sink.
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RTC battery

Before removing the RTC battery, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-22).

Remove the RTC battery:

1. Disconnect the RTC battery cable 1 from the system board.

2. Detach the RTC battery 2 from the top cover. The RTC battery is attached to the top cover with 
double-sided tape.

Reverse this procedure to install the RTC battery.

Description Spare part number

RTC battery 581075-001
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Processor

✎ The processor spare part kit includes replacement thermal material.

Before removing the processor, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

b. Fan and heat sink (see “Fan and heat sink” on page 4-35)

Description Spare part number

Intel® Core™ i5 dual-core processors (3-MB L3 cache, 4 threads, 35W): 

■ i5-520M, 2.4-GHz processor (Turbo up to 2.93 GHz) 594187-001

■ i5-540M, 2.53-GHz processor (Turbo up to 3.06 GHz) 594188-001

Intel® Core™ i7 quad-core, processor (6-MB L3 cache, 8 threads, 45W): 

■ i7-620M, 2.66-GHz processor (Turbo up to 3.33GHz) 587259-001

Intel® Core™ i7 quad-core, processors: 

■ i7-720QM, 1.6-GHz processor (Turbo up to 2.8 GHz, 6-MB L3 cache, 8 threads, 45W) 586170-001

■ i7-820QM, 1.73-GHz processor (Turbo up to 3.06 GHz, 8-MB L3 cache, 8 threads, 45W) 583053-001
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Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw 1 one-half turn counterclockwise, until you 
hear a click.

✎Unlocking and locking directions are embossed on the processor socket.

2. Lift the processor 2 straight up and remove it.

✎When you install the processor, align the gold triangle 3 etched on top of the processor with the triangle embossed 
on the processor socket 4.

Clean and replace any thermal material, and then reverse this procedure to install the processor.
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Top cover

✎ The top cover spare part kit includes TouchPad assembly, cable, and bracket; the ESD boards; the smart card 
reader; and on some models, a fingerprint reader and bracket.

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the 3 rubber screw covers 1, the 6 Torx T8M2.5×6.0 screws 2, and the 2 Phillips PM2.5×3.0 
screws 3 in the hard drive bay that secure the top cover to the base enclosure.

Description Spare part number

Top cover with integrated smart card reader and fingerprint reader for use on HP EliteBook 8440p 594098-001

Top cover with integrated smart card reader and fingerprint reader for use on HP EliteBook 8440w 594099-001

Top cover with integrated smart card reader without fingerprint reader for use on HP EliteBook 
8440w (Plastics Kit includes fingerprint reader plug)

594100-001
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3. Turn the computer right-side up, with the front toward you.

4. Disconnect the touch pad cable 1, the fingerprint reader cable 2, and the ExpressCard reader cable 3 from the 
system board.

5. Remove the three Torx T8M2.5×6.0 screws that secure the top cover to the base enclosure.

6. Lift the rear edge 1 of the top cover until it detaches from the base enclosure.

7. Remove the top cover 2 by lifting it straight up.

Reverse this procedure to install the top cover. 
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Audio/ExpressCard board

Before removing the Audio/ExpressCard board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

g. Top cover (see “Top cover” on page 4-42)

Remove the Audio/ExpressCard board:

1. Release the speaker cable from the connector 1 on the Audio/ExpressCard board.

2. Remove the two Phillips PM2.0×4.0×7.0 broadhead screws 2 and the Phillips PM2.0×4.0 3 screw from the 
Audio/ExpressCard board.

3. Lift the right edge of the Audio/ExpressCard board 4 up. 

4. Slide the Audio/ExpressCard board 5 to the right to clear the audio connectors from the base enclosure.

5. Remove the Audio/ExpressCard board.

Reverse this procedure to install the Audio/ExpressCard board.

Description Spare part number

Audio/ExpressCard board 594024-001
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Speakers

Before removing the speakers, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

g. Top cover (see “Top cover” on page 4-42)

h. Audio/ExpressCard (see “Audio/ExpressCard board” on page 4-44)

Remove the speakers:

1. Remove the Phillips PM2.5×4.0 screw 1 that secures the left speaker to the base enclosure.

2. Lift the left speaker straight up 2 to remove the left speaker.

3. Lift the right speaker up and to the left 3 to remove the right speaker.

Reverse this procedure to install the speakers.

Description Spare part number

Speakers (include cables) 594094-001
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Bluetooth module and cable

✎ The Bluetooth module spare part does not include the Bluetooth module cable. The Bluetooth module cable is 
included in the Cable Kit, spare part number 594030-001.

Before removing the Bluetooth module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

g. Top cover (see “Top cover” on page 4-42)

h. Audio/ExpressCard (see “Audio/ExpressCard board” on page 4-44)

i. Speakers (see “Speakers” on page 4-45)

Description Spare part number

Bluetooth module 594030-001
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Remove the Bluetooth module and cable: 

1. Loosen the Phillips PM2.0×4.0 captive screw 1.

2. Swing the Bluetooth compartment cover open 2 to the right. 

3. Shift the Bluetooth module right 1 and lift it up 2 until it clears the clips built into the Bluetooth module 
compartment cover.

4. Remove the Bluetooth module 3 from the Bluetooth module compartment cover.

5. Disconnect the Bluetooth module cable 4 from the Bluetooth module.

6. Remove the Bluetooth module.
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7. If it is necessary to replace the Bluetooth module cable:

✎The Bluetooth module cable is included in the Cable Kit, spare part number 594030-001.

a. Disconnect the Bluetooth module cable 1 from the system board.

b. Remove the Bluetooth module cable 2 from the cable routing channel in the base enclosure.

Reverse this procedure to install the Bluetooth module and cable.
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Modem module

✎ The modem module cable is included in the Cable kit, spare part number 594030-001.

Before removing the modem module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

g. Top cover (see “Top cover” on page 4-42)

h. Audio/ExpressCard (see “Audio/ExpressCard board” on page 4-44)

i. Speakers (see “Speakers” on page 4-45)

Remove the modem module:

1. Remove the 2 Phillips PM2.0×4.0 screws 1 that secure the modem module to the system board.

2. Lift the modem module 2 away from the system board.

3. Disconnect the modem module cable 3 to remove the modem module.

Reverse this procedure to install the modem module.

Description Spare part number

High-speed 56k modem for use in all countries and regions except Australia and New Zealand 510099-001

High-speed 56k modem for use only in Australia and New Zealand 510099-011
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System board

✎ The system board spare part kit includes replacement thermal material.

Before removing the system board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components:

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

g. Top cover (see “Top cover” on page 4-42)

h. Audio/ExpressCard (see “Audio/ExpressCard board” on page 4-44)

i. Speakers (see “Speakers” on page 4-45)

j. Modem (see “Modem module” on page 4-49)

When replacing the system board, be sure that the following additional components are removed from the defective 
system board and installed on the replacement system board: 

■ SIM (see “SIM” on page 4-8)

■ WLAN module (see “WLAN module” on page 4-11)

■ Memory modules (see “Memory module” on page 4-16)

■ WWAN module (see “WWAN module” on page 4-14)

■ Modem module (see “Modem module” on page 4-49)

■ Fan and heat sink (see “Fan and heat sink” on page 4-35)

■ RTC battery (see “RTC battery” on page 4-39)

■ Processor (see “Processor” on page 4-40)

Description Spare part number

System board for use with HP EliteBook 8440p discrete graphics subsystem 594026-001

System board for use with HP EliteBook 8440w discrete graphics subsystem 594027-001

System board for use with HP EliteBook 8440p UMA graphics subsystem 594028-001
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Remove the system board:

1. Remove the Phillips PM2.0×4.0 screw 1 that secures the thermal heat shield to the base enclosure and 
compresses the thermal material to the platform controller hub (PCH) chip on the system board.

2. Lift the thermal shield straight up 2 to remove it.

✎The thermal shield and system board spare parts include replacement thermal material. Clean and install new 
thermal material when replacing the thermal shield.

3. Remove the 2 Phillips PM2.5×4.0 screws 1 that secure the system board to the base enclosure.

4. Use the optical drive connector 2 to lift the system board away from the base enclosure.

5. Remove the system board 3 by lifting it to the right at an angle until the connectors clear the base enclosure.

Reverse this procedure to install the system board.
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Modem module cable

✎ The modem module cable is included in the Cable kit, spare part number 594030-001.

Before removing the modem module cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Wireless modules antenna cables (see “WLAN module” on page 4-11 and “WWAN module” on page 4-14)

c. Optical drive (see “Optical drive” on page 4-20)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-22)

e. Display assembly (see “Display assembly” on page 4-27)

f. RTC battery (see “RTC battery” on page 4-39)

g. Top cover (see “Top cover” on page 4-42)

h. Audio/ExpressCard (see “Audio/ExpressCard board” on page 4-44)

i. Speakers (see “Speakers” on page 4-45)

j. Modem module (“Modem module” on page 4-49)

k. System board (“System board” on page 4-50)

Remove the modem module cable:

1. Release the RJ-11 connector 1 from the clip built into the base enclosure.

2. Remove the modem module cable 2 from the clips and the cable channel 3 built into the base enclosure.

Reverse this procedure to install the modem module cable.
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5
Computer Setup

Computer Setup in Windows 7

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

✎ An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and 
make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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Computer Setup
To exit Computer Setup menus, choose one of the following methods:
■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 

screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values configured at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.
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Computer Setup
File menu

Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Select To do this

System Information ■ View identification information for the computer and 
the batteries in the system.

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version.

Set System Date and Time Set or change the date and time on the computer. 

System Diagnostics Displays the following information: 

■ System Information 

❐ Identification information for the computer and the 
batteries in the system. 

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version. 

■ Start-up Test—Verifies the system components needed for 
starting the computer. 

■ Run-In Test—Runs a comprehensive check on system 
memory. 

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system. 

■ Memory Test—Runs a comprehensive test on any memory 
installed in the computer. 

■ Battery Test—Runs a comprehensive test on any batteries 
installed in the computer. 

■ Error Log—Displays a log file if any errors have occurred. 

Restore Defaults Replace the configuration settings in Computer Setup with 
the original factory settings. (Hard drive mode, password 
settings, and security settings are not changed when you 
restore the factory settings.

Reset BIOS security to factory default Restore the BIOS security settings to the factory default. 

Ignore Changes and Exit Cancel any changes entered during the current session. 
Then exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then 
exit and restart the computer. Your changes go into effect 
when the computer restarts. 

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) 

Create New BIOS User Account ■ Select from a list of BIOS users. 

■ Select from a list of ProtectTools users. 

(Continued)
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Security menu (continued)

Password Policy (requires a BIOS administrator password) Revise password policy criteria. 

HP SpareKey Enable/disable HP SpareKey (enabled by default). 

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default). 

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default). 

User Tools 

Change Password Enter, change, or delete a BIOS administrator password. 

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password. 

Anti Theft 

AT-P Enable/disable Anti-Theft Protection. 

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default). 

■ Change a DriveLock user password or master password. 

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) the 
computer. 

Automatic DriveLock Enable/disable Automatic DriveLock support. 

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) 
Embedded Security, which protects the computer from 
unauthorized access to owner functions available in 
Embedded Security for ProtectTools. For more information, 
refer to the ProtectTools software Help. 

✎ You must have a setup password to change this 
setting. 

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay. 

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently. 

System IDs Enter a user-defined computer asset tracking number and 
ownership tag. 

Select To do this
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System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language  Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds). 

■ Set the MultiBook Express Boot Popup delay in seconds. 

■ Enable/disable Custom Logo (disabled by default). 

■ Enable/disable Display Diagnostic URL (enabled by 
default). 

■ Enable/disable CD-ROM boot (enabled by default). 

■ Enable/disable SD Card boot (enabled by default). 

■ Enable/disable floppy boot (enabled by default). 

■ Enable/disable PXE Internal NIC boot (enabled by default). 

■ Enable/Disable Unified Extensible Firmware Interface 
(UEFI) Boot Mode (disabled by default). 

■ Set the Legacy Boot Order. 

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following: 

❐ Use of a USB keyboard in Computer Setup even when a 
Windows® operating system is not running 

❐ Startup from bootable USB devices, including a hard 
drive, diskette drive, or optical drive connected by a USB 
port to the computer 

■ Select a parallel port mode: ECP (Enhanced Capabilities 
Port), standard, bidirectional, or EPP (Enhanced Parallel 
Port). 

■ Enable/disable fan always on while connected to an AC 
outlet (enabled by default). 

■ Enable/disable Data Execution Prevention (select models 
only). When enabled, the processor can disable some 
virus code execution, which helps to improve computer 
security (disabled by default). 

■ Set the SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available: 

❐ AHCI (Advanced Host Controller Interface) 

❐ IDE (Integrated Drive Electronics) 
❐ RAID (select models only) 

✎ Availability of these options varies by computer model. 

■ Enable/disable secondary battery fast charge (enabled by 
default). 

■ Enable/disable HP QuickLook (enabled by default). 

■ Enable/disable Preboot Authentication on HP QuickLook 
Boot (enabled by default). 

■ Enable/disable HP QuickWeb (enabled by default).

■ Enable/disable HP QuickWeb Write Protect (disabled by 
default).

■ Enable/disable Virtualization Technology (select models 
only; disabled by default).

(Continued)
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System Configuration menu (continued)

Device Configurations (continued) ■ Enable/disable TXT (Intel Trusted Execution Technology) 
(select models only; disabled by default).

■ Enable/disable Multi Core CPU (enabled by default).

■ Enable/disable Intel HT Technology (enabled by default).

■ Enable/disable Wake on USB (enabled by default).

■ Enable/disable Num lock state at boot (disabled by 
default).

Built-In Device Options ■ Enable/disable the wireless button state (enabled by 
default). 

■ Enable/disable embedded WLAN device radio (select 
models only; enabled by default). 

■ Enable/disable the embedded Bluetooth® device radio 
(enabled by default). 

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default). 

■ Enable/disable LAN/WLAN switching (disabled by default). 

■ Set the wake on LAN state. Options include the following: 

❐ Disabled 
❐ Boot to Network 

❐ Follow Boot Order 

■ Enable/disable the Ambient Light Sensor. 

■ Enable/disable the Notebook Upgrade Bay device (enabled 
by default). 

■ Enable/disable the fingerprint device (enabled by default). 

■ Enable/disable the integrated camera (enabled by default). 

■ Enable/disable the Power Monitor Circuit (enabled by 
default). 

■ Enable/disable the audio device (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the microphone (enabled by default). 

■ Enable/disable the internal speakers (enabled by default). 

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the serial port. 

■ Enable/disable the parallel port. 

■ Enable/disable the flash media reader. 

■ Enable/disable the USB port. 

Ä Disabling the USB port also disables MultiBay 
devices and ExpressCard devices on the advanced 
port replicator. 

■ Enable/disable the 1394 port. 

■ Enable/disable the ExpressCard slot. 

■ Enable/disable the Smart Card slot. 

■ Enable/disable the eSATA port 

(Continued)
5–6 Maintenance and Service Guide



Computer Setup
System Configuration menu (continued)

AMT Options ■ Enable/disable Firmware Verbosity. 

■ Enable/disable AMT Setup Prompt (Ctrl-P). 

■ Enable/disable USB Key Provisioning Support. 

■ Enable/disable Unconfigure AMT on next boot. 

■ Select Terminal Emulation Mode. 

❐ ANSI 

❐ VT100 

■ Enable/disable Firmware Progress Event Support. 

■ Enable/disable Initiate Intel CIRA. 

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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Computer Setup in Windows Vista

Starting Computer Setup 

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

✎ An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate 
and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values configured at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File menu

Select To do this

System Information ■ View identification information for the computer and the 
batteries in the system. 

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version. 

Set System Data and Time ■ Set or change the date and time on the computer.

System Diagnostics ■ System Information 

❐ Identification information for the computer and the 
batteries in the system.

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version.

■ Start-up Test—Verifies the system components needed for 
starting the computer. 

■ Run-In Test—Runs a comprehensive check on system 
memory. 

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system. 

(Continued)
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Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

File menu (continued)

System Diagnostics (continued) ■ Memory Test—Runs a comprehensive test on any memory 
installed in the computer. 

■ Battery Test—Runs a comprehensive test on any batteries 
installed in the computer. 

■ Error Log—Displays a log file if any errors have occurred. 

Restore Defaults Replace the configuration settings in Computer Setup with the 
original factory settings. (Hard drive mode, password settings, 
and security settings are not changed when you restore the 
factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore Changes and Exit Cancel any changes entered during the current session. Then 
exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then 
exit and restart the computer. Your changes go into effect 
when the computer restarts.

Select To do this

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) 

Create New BIOS User Account ■ Select from a list of BIOS users. 

■ Select from a list of ProtectTools users. 

Password Policy (requires a BIOS administrator password) Revise password policy criteria. 

HP SpareKey Enable/disable HP SpareKey (enabled by default). 

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default). 

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default). 

User Tools 

Change Password Enter, change, or delete a BIOS administrator password. 

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password. 

Anti Theft 

AT-P Enable/disable Anti-Theft Protection. 

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default). 

■ Change a DriveLock user password or master password. 

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) the 
computer. 

(Continued)
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System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Security menu (continued)

Automatic DriveLock Enable/disable Automatic DriveLock support. 

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) 
Embedded Security, which protects the computer from 
unauthorized access to owner functions available in 
Embedded Security for ProtectTools. For more information, 
refer to the ProtectTools software Help. 

✎ You must have a setup password to change this 
setting. 

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay. 

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently. 

System IDs Enter a user-defined computer asset tracking number and 
ownership tag. 

Select To do this

Select To do this

Language  Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds). 

■ Set the MultiBook Express Boot Popup delay in seconds. 

■ Enable/disable Custom Logo (disabled by default). 

■ Enable/disable Display Diagnostic URL (enabled by 
default). 

■ Enable/disable CD-ROM boot (enabled by default). 

■ Enable/disable SD Card boot (enabled by default). 

■ Enable/disable floppy boot (enabled by default). 

■ Enable/disable PXE Internal NIC boot (enabled by default). 

■ Enable/Disable Unified Extensible Firmware Interface 
(UEFI) Boot Mode (disabled by default). 

■ Set the Legacy Boot Order. 

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following: 

❐ Use of a USB keyboard in Computer Setup even when a 
Windows® operating system is not running 

❐ Startup from bootable USB devices, including a hard 
drive, diskette drive, or optical drive connected by a USB 
port to the computer 

■ Select a parallel port mode: ECP (Enhanced Capabilities 
Port), standard, bidirectional, or EPP (Enhanced Parallel 
Port). 

■ Enable/disable fan always on while connected to an AC 
outlet (enabled by default). 

(Continued)
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Select To do this

System Configuration menu (continued)

Device Configurations (continued) ■ Enable/disable Data Execution Prevention (select models 
only). When enabled, the processor can disable some virus 
code execution, which helps to improve computer security 
(disabled by default).

■ Set the SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available: 

❐ AHCI (Advanced Host Controller Interface) 

❐ IDE (Integrated Drive Electronics) 

❐ RAID (select models only) 

✎ Availability of these options varies by computer model. 

■ Enable/disable secondary battery fast charge (enabled by 
default). 

■ Enable/disable HP QuickLook (enabled by default). 

■ Enable/disable Preboot Authentication on HP QuickLook 
Boot (enabled by default). 

■ Enable/disable HP QuickWeb (enabled by default).

■ Enable/disable HP QuickWeb Write Protect (disabled by 
default).

■ Enable/disable Virtualization Technology (select models 
only; disabled by default).

■ Enable/disable TXT (Intel Trusted Execution Technology) 
(select models only; disabled by default).

■ Enable/disable Multi Core CPU (enabled by default).

■ Enable/disable Intel HT Technology (enabled by default).

■ Enable/disable Wake on USB (enabled by default).

■ Enable/disable Num lock state at boot (disabled by default).

Built-In Device Options ■ Enable/disable the wireless button state (enabled by 
default). 

■ Enable/disable embedded WLAN device radio (select 
models only; enabled by default). 

■ Enable/disable the embedded Bluetooth® device radio 
(enabled by default). 

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default). 

■ Enable/disable LAN/WLAN switching (disabled by default). 

■ Set the wake on LAN state. Options include the following: 

❐ Disabled 

❐ Boot to Network 
❐ Follow Boot Order 

■ Enable/disable the Ambient Light Sensor. 

■ Enable/disable the Notebook Upgrade Bay device (enabled 
by default).

■ Enable/disable the fingerprint device (enabled by default). 

■ Enable/disable the integrated camera (enabled by default). 

■ Enable/disable the Power Monitor Circuit (enabled by 
default).

■ Enable/disable the audio device (enabled by default).

(Continued)
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System Configuration menu (continued)

Built-In Device Options (continued) ■ Enable/disable a modem device (enabled by default).

■ Enable/disable the microphone (enabled by default). 

■ Enable/disable the internal speakers (enabled by default). 

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the serial port. 

■ Enable/disable the parallel port. 

■ Enable/disable the flash media reader. 

■ Enable/disable the USB port. 

Ä Disabling the USB port also disables MultiBay 
devices and ExpressCard devices on the advanced 
port replicator. 

■ Enable/disable the 1394 port. 

■ Enable/disable the ExpressCard slot. 

■ Enable/disable the Smart Card slot. 

■ Enable/disable the eSATA port 

AMT Options ■ Enable/disable Firmware Verbosity. 

■ Enable/disable AMT Setup Prompt (Ctrl-P). 

■ Enable/disable USB Key Provisioning Support. 

■ Enable/disable Unconfigure AMT on next boot. 

■ Select Terminal Emulation Mode. 

❐ ANSI 

❐ VT100 
■ Enable/disable Firmware Progress Event Support. 

■ Enable/disable Initiate Intel CIRA. 

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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Computer Setup in Windows XP

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

✎ An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to 
navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:
■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 

screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.
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Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values configured at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File menu

Select To do this

System Information ■ View identification information for the computer and the 
batteries in the system. 

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version. 

Set System Data and Time ■ Set or change the date and time on the computer.

System Diagnostics ■ System Information 

❐ Identification information for the computer and the 
batteries in the system.

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version.

■ Start-up Test—Verifies the system components needed for 
starting the computer. 

■ Run-In Test—Runs a comprehensive check on system 
memory. 

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system. 

(Continued)
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Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

File menu (continued)

System Diagnostics (continued) ■ Memory Test—Runs a comprehensive test on any memory 
installed in the computer. 

■ Battery Test—Runs a comprehensive test on any batteries 
installed in the computer. 

■ Error Log—Displays a log file if any errors have occurred. 

Restore Defaults Replace the configuration settings in Computer Setup with 
the original factory settings. (Hard drive mode, password 
settings, and security settings are not changed when you 
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore Changes and Exit Cancel any changes entered during the current session. Then 
exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then 
exit and restart the computer. Your changes go into effect 
when the computer restarts.

Select To do this

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) 

Create New BIOS User Account ■ Select from a list of BIOS users. 

■ Select from a list of ProtectTools users. 

Password Policy (requires a BIOS administrator password) Revise password policy criteria. 

HP SpareKey Enable/disable HP SpareKey (enabled by default). 

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default). 

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default). 

User Tools 

Change Password Enter, change, or delete a BIOS administrator password. 

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password. 

Anti Theft 

AT-P Enable/disable Anti-Theft Protection. 

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default). 

■ Change a DriveLock user password or master password. 

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) the 
computer. 

(Continued)
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System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Security menu (continued)

Automatic DriveLock Enable/disable Automatic DriveLock support. 

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) 
Embedded Security, which protects the computer from 
unauthorized access to owner functions available in 
Embedded Security for ProtectTools. For more information, 
refer to the ProtectTools software Help. 

✎ You must have a setup password to change this 
setting. 

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay. 

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently. 

System IDs Enter a user-defined computer asset tracking number and 
ownership tag. 

Select To do this

Select To do this

Language  Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds). 

■ Set the MultiBook Express Boot Popup delay in seconds. 

■ Enable/disable Custom Logo (disabled by default). 

■ Enable/disable Display Diagnostic URL (enabled by 
default). 

■ Enable/disable CD-ROM boot (enabled by default). 

■ Enable/disable SD Card boot (enabled by default). 

■ Enable/disable floppy boot (enabled by default). 

■ Enable/disable PXE Internal NIC boot (enabled by default). 

■ Enable/Disable Unified Extensible Firmware Interface 
(UEFI) Boot Mode (disabled by default). 

■ Set the Legacy Boot Order. 

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following: 

❐ Use of a USB keyboard in Computer Setup even when a 
Windows® operating system is not running 

❐ Startup from bootable USB devices, including a hard 
drive, diskette drive, or optical drive connected by a USB 
port to the computer 

■ Select a parallel port mode: ECP (Enhanced Capabilities 
Port), standard, bidirectional, or EPP (Enhanced Parallel 
Port). 

■ Enable/disable fan always on while connected to an AC 
outlet (enabled by default).

(Continued)
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Select To do this

System Configuration menu (continued)

Device Configurations (continued) ■ Enable/disable Data Execution Prevention (select models 
only). When enabled, the processor can disable some virus 
code execution, which helps to improve computer security 
(disabled by default).

■ Set the SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available: 

❐ AHCI (Advanced Host Controller Interface) 

❐ IDE (Integrated Drive Electronics) 

❐ RAID (select models only) 

✎Availability of these options varies by computer model. 

■ Enable/disable secondary battery fast charge (enabled by 
default). 

■ Enable/disable HP QuickLook (enabled by default). 

■ Enable/disable Preboot Authentication on HP QuickLook 
Boot (enabled by default). 

■ Enable/disable HP QuickWeb (enabled by default).

■ Enable/disable HP QuickWeb Write Protect (disabled by 
default).

❐ Enable/disable Virtualization Technology (select models 
only; disabled by default).

■ Enable/disable TXT (Intel Trusted Execution Technology) 
(select models only; disabled by default).

■ Enable/disable Multi Core CPU (enabled by default).

■ Enable/disable Intel HT Technology (enabled by default).

■ Enable/disable Wake on USB (enabled by default).

■ Enable/disable Num lock state at boot (disabled by default).

Built-In Device Options ■ Enable/disable the wireless button state (enabled by 
default). 

■ Enable/disable embedded WLAN device radio (select 
models only; enabled by default). 

■ Enable/disable the embedded Bluetooth® device radio 
(enabled by default). 

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default). 

■ Enable/disable LAN/WLAN switching (disabled by default). 

■ Set the wake on LAN state. Options include the following: 

❐ Disabled 

❐ Boot to Network 

❐ Follow Boot Order 
■ Enable/disable the Ambient Light Sensor. 

■ Enable/disable the Notebook Upgrade Bay device (enabled 
by default).

■ Enable/disable the fingerprint device (enabled by default). 

■ Enable/disable the integrated camera (enabled by default). 

■ Enable/disable the Power Monitor Circuit (enabled by 
default).

■ Enable/disable the audio device (enabled by default).

■ Enable/disable a modem device (enabled by default).

(Continued)
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System Configuration menu (continued)

Built-In Device Options (continued) ■ Enable/disable the microphone (enabled by default). 

■ Enable/disable the internal speakers (enabled by default). 

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the serial port. 

■ Enable/disable the parallel port. 

■ Enable/disable the flash media reader. 

■ Enable/disable the USB port. 

Ä Disabling the USB port also disables MultiBay 
devices and ExpressCard devices on the advanced 
port replicator. 

■ Enable/disable the 1394 port. 

■ Enable/disable the ExpressCard slot. 

■ Enable/disable the Smart Card slot. 

■ Enable/disable the eSATA port 

AMT Options ■ Enable/disable Firmware Verbosity. 

■ Enable/disable AMT Setup Prompt (Ctrl-P). 

■ Enable/disable USB Key Provisioning Support. 

■ Enable/disable Unconfigure AMT on next boot. 

■ Select Terminal Emulation Mode. 

❐ ANSI 

❐ VT100 
■ Enable/disable Firmware Progress Event Support. 

■ Enable/disable Initiate Intel CIRA. 

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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6
Specifications

Computer specifications

Metric U.S.

Dimensions

Depth 23.62 cm 9.30 in

Width 33.56 cm 13.21 in

Height (front to back) 3.13 to 3.49 cm 1.23 to 1.37 in

Weight

With 14-in SVA display assembly, UMA graphics, 4-cell 
battery,1 512 MB SODIMM, WLAN card and antennas, 
WWAN minicard connector, SIM connector, and WWAN 
antennas, universal wideband antenna, no optical disk 
drive, no Bluetooth module

2.12 kg 4.68 lb

Input power

Operating voltage 19.5 V dc±5% @ 3.33 A - 65 W 
19.5 V dc±5% @ 4.62 A - 90 W

Operating current (max load) 3.33 A or 4.62 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine 

Nonoperating 200 g, 2 ms, half-sine 

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate 

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate 

✎ Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this 
range of temperatures.
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Specifications
14.0-in SVA eDP display specifications

Metric U.S. 

Dimensions

Height 17.74 cm 6.9 in

Width 31.30 cm 12.3 in

Diagonal 35.56 cm 14.0 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Aspect ratio 16:9

Pixel resolution

Pitch 0.279 × 0.279 mm 

Format 1366 × 768 - HD
1600 × 900 - HD+

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120°/-40° vertical (typical)
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Specifications
Hard drive specifications

500-GB* 320-GB* 250-GB*

Dimensions

Height 9.5 mm (0.37 in) 9.5 mm (0.37 in) 9.5 mm (0.37 in)

Width 70 mm (2.76 in) 70 mm (2.76 in) 70 mm (2.76 in)

Weight 101 g (3.56 oz) 101 g (3.56 oz) 101 g (3.56 oz)

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms 2.0 ms

Average 12.0 ms 12.0 ms 12.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms

Logical blocks 976,785,075 625,142,448 488,397,168

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly.

✎ Certain restrictions and exclusions apply. Contact technical support for details.
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Specifications
Solid state drive specifications

256-GB* 160-GB*

Dimensions

Height 9.5 mm (0.37-in) 7.0 mm (0.28-in)

Length 100 mm (3.94-in) 100 mm (3.94-in)

Width 70 mm (2.76) 70 mm (2.76)

Weight 80 g (2.82 oz) 76 g (2.68 oz)

Interface type SATA SATA

Read/Write bandwidth

Sequential read 220 MB/sec 250 MB/sec

Sequential write 200 MB/sec 70 MB/sec

Security ATA security ATA security

User Addressable Sectors 500,118,192 312,581,80

Operating temperature 0°C to 70°C (32°F to 158°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly.

✎ Certain restrictions and exclusions apply. Contact technical support for details.
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Specifications
Blu-ray R/RE DVD±RW SuperMulti Drive specifications

Applicable disc 

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, 
mixed-mode CD, CD-I, CD-I Bridge (Photo-CD, Video CD), 
Multisession CD (Photo-CD, CD-Extra, Portfolio, CD-R, CD-RW), 
CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), 
DVD-R, DVD-RW, DVD+R, DVD+RW. DVD-RAM, BD-ROM, 
BD-R, BD-RE

Write CD-R, CD-RW, DVD+R, DVD+R(9), DVD+RW, DVD-R, 
DVD-R(9), DVD-RW, DVD-RAM, BD-R, BD-RE

Random Access time

BD < 230 ms 

DVD < 180 ms

CD < 180 ms

Max media capacity

Read 50 GB

Write 50 GB

Cache buffer 2 MB 

Data transfer rate 

24X CD-ROM 3600 KB/sec 

8X DVD-ROM 10,800 KB/sec 

2X BD-ROM 9000 KB/sec 

24X CD-R 3600 KB/sec 

16X CD-RW 2400 KB/sec 

8X DVD+R 10800 KB/sec 

6X DVD+RW 8100 KB/sec 

8X DVD-R 10800 KB/sec 

6X DVD-RW 8100 KB/sec 

4X DVD+R Dual Layer 5400 KB/sec 

4X DVD-R Dual Layer 5400 KB/sec 

5X DVD-RAM 6750 KB/sec 

2X BD-R 9000 KB/sec 

2X BD-RE 9000 KB/sec 

2X BD-RAM 9 MB/sec 
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Specifications
Blu-ray ROM with LightScribe DVD±RW SuperMulti DL Drive specifications

Applicable disc 

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, 
Mixed-Mode CD, CD-I, CD-I Bridge (Photo-CD, Video CD), 
Multisession CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, 
CD-RW), CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW. DVD-RAM, 
BD-ROM, BD-R, BD-RE

Write CD-R, CD-RW, DVD+R, DVD+R(9), DVD+RW, DVD-R, DVD-R(9), 
DVD-RW, DVD-RAM, LightScribe

Random Access time

BD < 230 ms 

DVD < 190 ms

CD < 190 ms

Max media capacity

Read 50 GB

Write 8.5 GB

Cache buffer 4.5 MB 

Data transfer rate 

24X CD-ROM 3600 KB/s

8X DVD-ROM 10,800 KB/s

4X BD-ROM 18000 KB/s

16X CD-R 1200 KB/s

10X CD-RW 1500 KB/s

8X DVD+R 10800 KB/s

8X DVD+RW 10800 KB/s

8X DVD-R 10800 KB/s

6X DVD-RW 8100 KB/s

4X DVD+R Dual Layer 5400 KB/s

4X DVD-R Dual Layer 5400 KB/s

5X DVD-RAM 6750 KB/s
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Specifications
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

Applicable disc

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, 
Mixed-Mode CD, CD-I, CD-I Bridge (Photo-CD, Video CD), 
Multisession CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, 
CD-RW), CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW. DVD-RAM

Write CD-R, CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM, 
LightScribe

Random Access time

CD < 150 ms 

DVD < 160 ms

Max media capacity

Read 8.5 GB

Write 8.5 GB

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3600 KB/s

8X DVD-ROM 10,800 KB/s

24X CD-R 3600 KB/s

16X CD-RW 2400 KB/s

8X DVD+R 10,800 KB/s

8X  DVD+RW 10800 KB/s

8X DVD-R 10,800 KB/s

6X DVD-RW 8100 KB/s

4X DVD+R Dual Layer 5400 KB/s

4X DVD-R Dual Layer 5400 KB/s

5X DVD-RAM 6750 KB/s
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Specifications
DVD-ROM Drive specifications

Applicable disc

Read: CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, 
Mixed-Mode CD, CD-I, CD-I Bridge (Photo-CD, Video CD), 
Multisession CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, 
CD-RW), CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Random Access time

CD < 140 ms 

DVD < 160 ms

Max media capacity

Read 8.5 GB

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec
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Specifications
System resource specifications

You can use Device Manager to get a graphical view of the system resources that control how the devices work on 
the computer. System resources you can access from Device Manager are direct memory access (DMA) channels, 
input/output (I/O) ports, interrupt request (IRQ) lines, and memory addresses.

If two devices require the same resource and create a device conflict, you can manually change the resource 
settings in Device Manager to be sure each setting is unique.

Ä
CAUTION: Improperly changing resource settings can disable your hardware and cause your computer to malfunction or 
become inoperable. Only users who have expert knowledge of computer hardware and hardware configurations should change 
resource settings.

To view resource settings in Windows 7 and Windows Vista:

1. Select Start > Computer. 

2. Click System properties near the top of the Computer folder. 

3. On the left, click Device Manager. 

4. On the View menu, click one of the following:

❏ Resources by type

❏ Resources by connection

To view resource settings in Windows XP:

1. Select Start > My Computer, or double-click My Computer on the desktop.
2. Under System Tasks, click View system information. 

3. In the System Properties window, select the Hardware tab.

4. Click Device Manager.

5. On the View menu, click one of the following:

❏ Resources by type

❏ Resources by connection
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7
Backup and recovery

Backup and recovery in Windows 7

Overview

To protect your information, use Windows® Backup and Restore to back up individual files and folders, back up 
your entire hard drive (select models only), create system repair discs (select models only), or create system restore 
points. In case of system failure, you can use the backup files to restore the contents of your computer.

Windows Backup and Restore provides the following options:

■ Creating a system repair disc (select models only)

■ Backing up individual files and folders

■ Creating a system image (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create system repair discs 
(select models only) and your initial backup immediately after software setup. As you add new software and data 
files, you should continue to back up your system on a regular basis to maintain a reasonably current backup. The 
system repair discs (select models only) are used to start up (boot) the computer and repair the operating system in 
case of system instability or failure. Your initial and subsequent backups allow you to restore your data and settings 
if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents library, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.
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2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of 
optical drive installed in your computer.

✎ DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for backup 
reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or 
create a system repair disc (select models only).

✎Windows® includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, 
or changing Windows settings. Refer to Help and Support for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to boot (start up) your computer and you cannot use the system repair discs you previously 
created (select models only), you must purchase a Windows 7 operating system DVD to reboot the computer and 
repair the operating system. For additional information, refer to the “Using a Windows 7 operating system DVD 
(purchased separately)” section in this guide.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.
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✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. 

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and then click Disk 
Management.

✎ If the Windows partition or the HP Recovery partition is not listed, you must recover your operating 
system and programs using the Windows 7 operating system DVD and the Driver Recovery disc (both 
purchased separately). For additional information, refer to the “Using a Windows 7 operating system 
DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then press f8 
before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

✎ For additional information on recovering information using the Windows tools, perform a search for these topics 
in Help and Support.

Using f11 recovery tools

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP 
programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled. Personal files 
must be restored from a backup.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer, click 
Manage, and then click Disk Management.

✎ If the HP Recovery partition is not listed, you must recover your operating system and programs using the 
Windows 7 operating system DVD and the Driver Recovery disc (both purchased separately). For additional 
information, refer to the “Using a Windows 7 operating system DVD (purchased separately)” section in this 
guide.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the ESC key 
for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you previously 
created (select models only), you must purchase a Windows 7 operating system DVD to reboot the computer and 
repair the operating system. Be sure that your most recent backup (stored on discs or on an external drive) is easily 
accessible. To order a Windows 7 operating system DVD, go to http://www.hp.com/support, select your country or 
region, and follow the on-screen instructions. You can also order the DVD by calling technical support. For contact 
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

Ä
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats the hard drive. All 
files you have created and any software installed on the computer are permanently removed. The recovery process reinstalls the 
original operating system, software, and drivers. Software, drivers, and updates not installed by HP must be manually reinstalled.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before the 
Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders, back up 
your entire hard drive (select models only), or create system restore points. In case of system failure, you can use 
the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

■ Backing up individual files and folders

■ Backing up the entire hard drive (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support.

✎ In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup. You can back up your information to an optional 
external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents folder, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.
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■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of 
optical drive installed in your computer.

✎ DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for 
backup reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

✎ The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use the Backup and Restore Center to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to startup the computer, you must purchase a Windows Vista operating system DVD to restart 
the computer and repair the operating system. For additional information, refer to the “Using a Windows Vista 
operating system DVD (purchased separately)” section in this chapter.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.
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To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find the 
partitions, select Start > Computer.

✎ If the Windows partition and the HP Recovery partition have been deleted, you must recover your operating 
system and programs using the Windows Vista operating system DVD and the Driver Recovery software (both 
purchased separately). For additional information, refer to the “Using a Windows Vista operating system 
DVD (purchased separately)” section in this chapter.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

✎ For additional information on recovering information using the Windows tools, perform a search for these topics 
in Help and Support.

Using f11 recovery tools

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP 
programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled. Personal files 
must be restored from a backup.

✎ If your computer includes a solid-state drive (SSD), you may not have a recovery partition. Recovery discs have 
been included for computers that do not have a partition. Use these discs to recover your operating system and 
software. To check for the presence of a recovery partition, select Start > Computer. If the partition is present, 
an HP Recovery drive is listed in the Hard Disk Drives section of the window.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select 
Start > Computer.

✎ If the HP Recovery partition has been deleted, you must recover your operating system and programs using the 
Windows Vista operating system DVD and the Driver Recovery software (both purchased separately). For 
additional information, refer to the “Using a Windows Vista operating system DVD (purchased 
separately)” section in this chapter.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message 
is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased separately)

If you are unable to startup your computer, you must purchase a Windows Vista operating system DVD to restart 
the computer and repair the operating system. Be sure that your most recent backup (stored on discs or on an 
external drive) is easily accessible. To order a Windows Vista operating system DVD, go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. You can also order the 
DVD by calling technical support. For contact information, refer to the Worldwide Telephone Numbers booklet 
included with the computer.

Ä
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and reformats the hard drive. 
All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, 
the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery
Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and folders or 
create recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

■ Backing up individual files and folders

■ Backing up all files and folders

■ Scheduling automatic backups

■ Creating recovery points

■ Recovering information

✎ For detailed instructions, perform a search for these topics in Help and Support.

✎ In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup. You can back up individual files or folders to an 
optional external hard drive or to a network drive.

Note the following when backing up:

■ Store personal files in the My Documents folder, and back it up periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

✎ The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.
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Backup and recovery
2. Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools (select models only): You can use the Windows Backup utility to recover information 
you have previously backed up.

■ Operating System and Driver Recovery discs (included with your computer): You can use the discs to recover 
your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Select Restore files and settings, and then select Next.

4. Follow the on-screen instructions.

✎ For additional information on initiating a recovery in Windows, perform a search for this topic in 
Help and Support.

Recovering the operating system and programs

Ä
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have created and any software 
installed on the computer are permanently removed. The recovery process reinstalls the original operating system as well as 
software and drivers. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be 
restored from a backup.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver 
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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8
Connector pin assignments

Audio-out (headphone)

Audio-in (microphone)

 

Pin Signal 

1 Audio out, left channel 

2 Audio out, right channel 

3 Ground 

Pin Signal 

1 Audio signal in 

2 Audio signal in 

3 Ground 
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Connector pin assignments
1394a

External monitor

 

Pin Signal 

1 Send data, twisted pair B- 

2 Send, twisted pair B+ 

3 Receive data, twisted pair A- 

4 Receive, twisted pair A+

Pin Signal 

1 Red analog 

2 Green analog 

3 Blue analog 

4 Not connected 

5 Ground 

6 Ground analog 

7 Ground analog 

8 Ground analog 

9 +5 VDC 

10 Ground 

11 Monitor detect 

12 DDC 2B data 

13 Horizontal sync 

14 Vertical sync 

15 DDC 2B clock 
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Connector pin assignments
DisplayPort

✎ This is the pinout for the source-side connector; the sink-side connector pinout has lanes 0-3 reversed in order, 
that is, lane 3 will be on pin 1 and 3 while lane 0 will be on pin 10 and 12.

 

Pin Signal

1 Lane 0 - 

2 Ground

3 Lane 0 + 

4 Lane 1 + 

5 Ground

6 Lane 1 - 

7 Lane 2 + 

8 Ground

9 Lane 2 - 

10 Lane 3 + 

11 Ground

12 Lane 3 - 

13 CONFIG1 connected to ground*

14 CONFIG2 connected to ground*

15 Auxiliary Channel +

16 Ground

17 Auxiliary channel - 

18 Hot plug detect

19 Return for power

20 Power

*Pins 13 and 14 may either be directly connected to ground or connected to ground through a pulldown device. 
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Connector pin assignments
RJ-11 (modem)

RJ-45 (network)

Pin Signal

1  Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

Pin Signal 

1 Transmit + 

2 Transmit 

3 Receive + 

4 Unused 

5 Unused 

6 Receive - 

7 Unused 

8 Unused 
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Connector pin assignments
Universal Serial Bus

 

Pin Signal 

1 +5 VDC 

2 Data 

3 Data + 

4 Ground 
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Connector pin assignments
eSATA/USB

Pin Signal

1 USB +5 VDC 

2 USB Data -

3 USB Data + 

4 USB Ground 

S1 eSATA Ground

S2 eSATA Transmit Data A+ 

S3 eSATA Transmit Data A-

S4 eSATA Ground

S5 eSATA Receive Data B- 

S6 eSATA Transmit Data B+ 

S7 eSATA Ground
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9
Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC, 
or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region 
where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where 
the computer is used.

Requirements for all countries and regions

The following requirements are applicable to all countries and regions:

■ The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the 
country or region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 
250 V AC, as required by the power system of each country or region.

■ The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of the computer.
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Power cord set requirements
Requirements for specific countries and regions

Country/region Accredited agency Applicable note number 

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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10
Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. 
Follow the local laws and regulations in your area for computer battery disposal.

Display

Å
WARNING: The backlight contains mercury. Caution must be exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this chapter can result in damage to display components. The only components intended for 
recycling purposes are the liquid crystal display (LCD) panel and the backlight. When you remove these components, handle 
them carefully.

✎ Materials Disposal. This HP product contains mercury in the backlight in the display assembly that might 
require special handling at end-of-life. Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact your local authorities, or see the Electronic 
Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight 1 and the liquid crystal display (LCD) panel 2.

✎ The procedures provided in this chapter are general disassembly instructions. Specific details, such as screw 
sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.
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Recycling
Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges 1 and the top and bottom inside edges 2 of the display bezel 
until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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Recycling
4. Disconnect all display panel cables 1 from the display inverter and remove the inverter 2.

5. Remove all screws 1 that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly 2 from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.
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Recycling
9. Use a sharp-edged tool to cut the tape 1 that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.
 

11. Remove the screws 1 that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover 2 and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the display panel.
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Recycling
16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Å
WARNING: The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging 
this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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Recycling
19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

1394a port
location 2–12
pin assignments 8–2

A
AC adapter, spare part number 3–13
accessory battery connector 2–13
ambient light sensor/connector board

illustrated 3–8
spare part number 3–3, 3–8, 4–27

AMT options 5–7, 5–13, 5–19
antenna

disconnecting 4–13, 4–15
location 2–3
removal 4–34
spare part number 4–27
WLAN product description 1–3
WWAN product description 1–3

Anti-Theft Protection 5–4, 5–10, 5–16
audio, product description 1–4
Audio/ExpressCard board

removal 4–44
spare part number 3–5, 4–44

audio-in jack
location 2–12
pin assignments 8–1

audio-out jack
location 2–12
pin assignments 8–1

B
base enclosure, spare part number 3–5
battery

bay 2–13
light 2–8, 2–10
release latch 2–13
removal 4–7
spare part number 3–5, 4–7

bays
battery 2–13
hard drive 2–13
upgrade drive 1–3, 2–12, 3–6

BIOS administrator password 5–3, 5–10, 5–16

Bluetooth module
compartment 2–10
removal 4–46
spare part number 3–7, 4–46

Bluetooth module cable
illustrated 3–10
removal 4–48
spare part number 3–4

Bluetooth module compartment cover
illustrated 3–11
removal 4–47
spare part number 3–4

Blu-ray R/RE DVD±RW SuperMulti Drive
precautions 4–2
removal 4–20
spare part number 3–6, 3–12, 4–20
specifications 6–5

Blu-ray ROM with LightScribe DVD±RW Super-
Multi DL Drive

precautions 4–2
removal 4–20
spare part number 3–6, 3–12, 4–20
specifications 6–6

boot options 5–5, 5–11, 5–17
boot order 5–5, 5–11, 5–17
bottom components 2–13
built-in device options 5–6, 5–12, 5–13, 5–18,
5–19
business card holder 2–13
buttons

Caps lock 2–5
display release 2–10
Num lock 2–5
pointing stick 2–7
power 2–4
QuickLook 2–4
QuickWeb 2–4
TouchPad 2–5, 2–7
volume down 2–5
volume mute 2–5
volume up 2–5
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Index
wireless 2–4
C
cable kit

contents 3–10
spare part number 3–4

cables, service considerations 4–1
Caps lock

button 2–5
light 2–9

compartments
memory module 2–13
wireless modules 2–13

components
bottom 2–13
buttons 2–4
display 2–2, 2–3
fingerprint reader 2–4
front 2–10
keys 2–6
left-side 2–12
lights 2–8
pointing device 2–7
rear 2–11
right-side 2–12
switches 2–4

computer feet
locations 4–6
spare part number 4–6

Computer Setup
File menu 5–3, 5–9, 5–15
Security menu 5–3, 5–10, 5–16
System Configuration menu 5–5, 5–11, 5–17

computer, specifications 6–1
connectors

1394a 2–12
accessory battery 2–13
audio in 2–12
audio out 2–12
DisplayPort 2–11
docking 2–13
eSATA 2–12
monitor 2–11
power 2–11
RJ-11 (modem) 2–12
RJ-45 (network) 2–12
service considerations 4–1
USB 2–12

D
device configurations 5–5, 5–6, 5–11, 5–12, 5–17,

5–18
digital card 1–4
Disk Sanitizer 5–4, 5–11, 5–17
diskette drive, product description 1–3
display

removal 4–27
spare part number 3–3, 4–27
specifications 6–2

display back cover
illustrated 3–9
spare part number 3–3, 3–9, 4–27, 4–34

display bezel
illustrated 3–8
removal 4–31
spare part number 3–3, 3–8, 4–27, 4–31

display cable
illustrated 3–8
removal 4–34
spare part number 3–3, 3–8, 4–27, 4–34

display components
illustrated 2–2, 2–3
recycling 10–1

display hinge covers
removal 4–33
spare part number 3–3, 4–27

display hinges
illustrated 3–8
removal 4–32
spare part number 3–3, 3–8, 4–27, 4–33

display inverter, removal 10–3
display panel

illustrated 3–8
removal 4–32

display release button 2–10
display switch, location 2–2
DisplayPort

location 2–11
pin assignments 8–3

docking connector 2–13
drive light 2–8, 2–10
DriveLock

automatic 5–4, 5–11, 5–17
password 5–4, 5–10, 5–16

drives, boot order 5–5, 5–11, 5–17
DVD±RW and CD-RW SuperMulti Double-Layer
Combo Drive with LightScribe

precautions 4–2
removal 4–20
spare part number 3–6, 3–12, 4–20
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Index
specifications 6–7
DVD-ROM Drive

precautions 4–2
removal 4–20
spare part number 3–6, 3–12, 4–20
specifications 6–8

E
electrostatic discharge 4–2
equipment guidelines 4–4
eSATA/USB

connector 2–12
pin assignments 8–6

esc key 2–6
Ethernet, product description 1–3
expansion memory compartment cover, illustrated
3–11
expansion memory module 4–16

removal 4–16
spare part number 3–6

ExpressCard slot 2–12
ExpressCard slot bezel, illustrated 3–11
external monitor port

location 2–11
pin assignments 8–2

F
fan

removal 4–35
spare part number 3–4, 4–35

feet
locations 4–6
spare part number 4–6

File menu 5–3, 5–9, 5–15
Fingerprint reader 2–5
fn key 2–6
front components 2–10
function keys 2–6
G
graphics subsystem, product description 1–1
grounding equipment and methods 4–2
H
hard drive

illustrated 3–12
precautions 4–2
product description 1–2
removal 4–9
spare part number 3–6, 4–9
specifications 6–3
upgrade bay 3–6

hard drive bay 2–13

hard drive bay cover
illustrated 3–11
removal 4–9
spare part number 3–4

hard drive bracket, removal 4–10
headphone jack, location 2–12
heat sink

removal 4–35
spare part number 3–4, 4–35

hinge covers
removal 4–33
spare part number 3–3, 4–27

hinges
removal 4–32
spare part number 3–3, 4–27, 4–33

HP SpareKey Enrollment 5–4, 5–10, 5–16
I
internal display switch 2–4
J
jacks

audio out 2–12
audio-in 2–12
audio-out 2–12
headphone 2–12
microphone 2–12
modem 2–12
network 2–12
RJ-11 (modem) 2–12
RJ-45 (network) 2–12

K
key components 2–6
keyboard

product description 1–4
removal 4–22
spare part number 3–3, 4–22

keyboard light button, location 2–2
keyboard light, location 2–2
keys

esc 2–6
fn 2–6
function 2–6
numeric keypad 2–6
Windows applications 2–6
Windows logo 2–6

L
language, changing in Computer Setup 5–5, 5–11,
5–17
left-side components 2–12
light components 2–8
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Index
lights
battery 2–8, 2–10
Caps lock 2–9
drive 2–8, 2–10
Num lock 2–9
power 2–8, 2–10
QuickLook 2–8
QuickWeb 2–8
TouchPad 2–8
volume down 2–9
volume mute 2–9
volume up 2–9
wireless 2–8, 2–10

M
mass storage devices

illustrated 3–12
spare part number 3–6

memory module
product description 1–2
removal 4–16
spare part number 4–16

memory module compartment 2–13
memory module compartment cover

removal 4–16
spare part number 3–4

microphone
locations 2–2
product description 1–3
removal 4–34
spare part number 3–9, 4–27

microphone jack
location 2–12
pin assignments 8–1

model name 4–5
model number 3–1
modem jack, location 2–12
modem module

product description 1–3
removal 4–49
spare part number 3–5, 4–49

modem module cable
illustrated 3–10
removal 4–52
spare part number 3–4

monitor port
location 2–11
pin assignments 8–2

N
network jack

location 2–12
pin assignments 8–4

Num lock
button 2–5
light 2–9

numeric keypad keys 2–6
O
optical drive

illustrated 3–12
precautions 4–2
product description 1–2
removal 4–20
spare part number 3–6, 4–20
specifications 6–6, 6–7, 6–8

optical drive bracket, removal 4–21
optical drive kit 3–6
P
packing guidelines 4–3
passwords 5–3, 5–10, 5–16
pin assignments

audio-in 8–1
audio-out 8–1
headphone 8–1
microphone 8–1
modem 8–4
monitor port 8–2
network 8–4
RJ-11 (modem) 8–4
RJ-45 (network) 8–4
Universal Serial Bus (USB) port 8–4

plastic parts 4–1
plastics kit

content 3–11
contents 3–11
spare part number 3–4

pointing device
components 2–7
illustrated 2–7
product description 1–4

pointing stick 2–7
pointing stick button 2–7
port options 5–6, 5–13, 5–19
ports

1394a 2–12
DisplayPort 2–11
external monitor 2–11
USB 2–12

power
button 2–4
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Index
light 2–8
power button board

removal 4–26
spare part number 3–3, 4–26

power connector 2–11
power cord

requirements 9–1
spare part number 3–13

power light, front 2–10
power requirements, product description 1–4
primary memory module

removal 4–18
spare part number 3–5

processor
product description 3–5, 4–40
removal 4–40
spare part number 3–5, 4–40

product description
audio 1–3
diskette drive 1–3
display panel 1–1
docking 1–4
external media card 1–4
hard drives 1–2
keyboard 1–4
memory 1–2
microphone 1–3
modem 1–3
operating system 1–5
optical drives 1–2
pointing devices 1–4
ports 1–4
power requirements 1–4
processor 1–1
security 1–5
serviceability 1–7
upgrade hard drive bay 1–3
webcam 1–3
wireless 1–3

product name 1–1, 4–5
Q
QuickLook

button 2–4
light 2–8

QuickWeb
button 2–4
light 2–8

R
rear components 2–11

recovery, system 7–1
recycling

battery 10–1
display components 10–1

removal/replacement
preliminaries 4–1
procedures 4–5

restoring factory settings 5–3, 5–10, 5–16
restoring security defaults 5–7, 5–13, 5–19
right-side components 2–12
RJ-11 (modem) jack

location 2–12
pin assignments 8–4
spare part number 3–4, 3–10

RJ-45 (network) jack
location 2–12
pin assignments 8–4

RTC battery
removal 4–39
spare part number 3–5, 4–39

rubber kit, spare part number 3–13, 4–6
S
screw kit

contents 3–13
spare part number 3–13

screw location
Phillips

M2.0 × 2.0 broadhead 4–23
M2.0 × 3.0 4–26
M2.0 × 4.0 4–21, 4–44, 4–47, 4–49, 4–51
M2.0 × 4.0 broadhead 4–44
M2.0 × 5.0 4–9, 4–12, 4–14
M2.0 × 5.0 captive 4–16
M2.5 × 10.0 4–20
M2.5 × 10.0 captive 4–10, 4–18, 4–23,

4–37
M2.5 × 3.0 4–33, 4–42
M2.5 × 4.0 4–13, 4–15, 4–45, 4–51
M2.5 × 5.0 4–32
M3.0 × 3.0 4–10

Torx
T8 M2.5 × 6.0 4–23, 4–42

SD Card Reader 2–10
security cable slot 2–11
security level, setting 5–7, 5–13, 5–19
Security menu 5–3, 5–10, 5–16

always prompt for HP SpareKey enrollment
5–4, 5–10, 5–16

Anti-Theft Protection 5–4, 5–10, 5–16
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Automatic DriveLock 5–4, 5–11, 5–17
change password 5–4, 5–10, 5–16
Disk Sanitizer 5–4, 5–11, 5–17
DriveLock 5–4, 5–10, 5–16
fingerprint reader ownership reset 5–4, 5–10,

5–16
HP SpareKey 5–4, 5–10, 5–16
HP SpareKey enrollment 5–4, 5–10, 5–16
password policy 5–4, 5–10, 5–16
set up BIOS administrator password 5–3, 5–10,

5–16
System IDs 5–4, 5–11, 5–17
TPM embedded security 5–4, 5–11, 5–17
user management 5–3, 5–10, 5–16

security, product description 1–5
serial number 3–1
service considerations 4–1
service tag

location 4–5
part number 4–5
serial number 4–5

serviceability, product description 1–7
SIM slot 2–13
SIM, removal 4–8
smartcard reader 2–12
solid state drive

illustrated 3–12
spare part number 3–6
specifications 6–4

spare part numbers, sequential listing 3–14
speakers 2–10

removal 4–45
spare part number 3–5, 4–45

specifications
Blu-ray R/RE DVD±RW SuperMulti Drive

6–5
Blu-ray ROM with LightScribe DVD±RW Su-

perMulti DL Drive 6–6
computer 6–1
display 6–2
DVD±RW and CD-RW SuperMulti Dou-

ble-Layer Combo Drive with Light-
Scribe 6–7

DVD-ROM Drive 6–8
hard drive 6–3
IRQ, DMA, I/O, and memory addresses 6–9
optical drive 6–6, 6–7, 6–8
solid state drive 6–4
system resources 6–9

switch cover
removal 4–22
spare part number 3–3, 4–22

switch, internal display 2–4
system board

removal 4–50
spare part number 3–5, 4–50

System Configuration menu 5–5, 5–11, 5–17
system IDs 5–4, 5–11, 5–17
system recovery 7–1
T
tag, service 4–5
thermal heatshield, spare part number 3–13
thermal material 3–5
tools required 4–1
top cover

removal 4–42
spare part number 3–5, 4–42

TouchPad 2–7
button 2–5
light 2–8

TouchPad buttons 2–7
TouchPad scroll zone 2–7
TPM embedded security 5–4, 5–11, 5–17
U
Universal Serial Bus (USB) port

location 2–12
pin assignments 8–5

upgrade bay, hard drive option 3–6
upgrade drive bay 2–12
V
vents 2–12, 2–13
volume down button 2–5
volume down light 2–9
volume mute button 2–5
volume mute light 2–9
volume up button 2–5
volume up light 2–9
W
warranty period 4–5
webcam light, location 2–2
webcam module

removal 4–34
spare part number 4–34

webcam, location 2–2
Windows applications key 2–6
Windows logo key 2–6
wireless

antenna
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disconnecting 4–13, 4–15
location 2–3
product description 1–1, 1–3
removal 4–34
spare part number 3–9

button 2–4
light 2–8, 2–10
module compartment 2–13
module compartment cover

illustrated 3–11
removal 4–12, 4–14
spare part number 3–4

WLAN module
illustrated 3–6
removal 4–11
spare part number 3–6, 4–11

WLAN module compartment cover
removal 4–14
spare part number 3–4

workstation guidelines 4–4
WWAN module

removal 4–14
spare part number 3–7, 4–14

WWAN module compartment cover
removal 4–14
spare part number 3–4
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